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1 Overview

Overview
This document describes the Maps 3.3 application software used on SEM/SDB, 
CorrSight™, and TEM systems.

Topics include:

 “Introduction” on page 3

 “Terminology” on page 4

 “System Requirements” on page 5

 “Data Storage Requirements” on page 5

 “Project Directory” on page 6

 “Package Options” on page 7

Introduction
The Maps software application provides users with the ability to focus on areas of interest 
within a sample region by organizing the sample into tiles and then navigating, selecting, 
and overlapping tiles so they can be viewed and analyzed in a higher level of detail than 
previously available.

The application will:

 Create a grid of a sample to enable efficient navigation and previews of selected tiles.

 Acquire tiled images in an automated fashion from multiple sample locations, with 
correlation between multiple layers.

 Find stitching information between tiles in an automated or semi-automated fashion 
using cross-correlation.

 Stitch and blend tiles into larger images with the capability to export them into 
common industry formats for viewing.

 Provide the capability to interactively display and investigate images constructed from 
multiple locations and layers of the sample.

 Process powerful workflows to do alignments or array tomography.

Maps complements the Correlative Workflow features that enable you to move samples 
between light microscopes and electron microscopes with the help of automated alignment 
on supported sample holders and a suite of powerful correlation tools.
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Maps provides a solution for correlative microscopy by facilitating workflows that involve 
optical microscopy, SEM, and/or TEM. Both automated and manual alignments are used 
for correlation of the data to truly understand the sample.

Terminology
 Alignment: In Maps, adjusts project data to the current stage position.

 Blending: The Maps software will create a smooth transition between images during 
stitching.

 Correlation: In Maps context, correlation is used for two things: 1. finding back areas 
of interest that show up in different modalities, and 2. for visually overlaying data sets 
that correspond to the same area on the sample.

 CorrSight: Fluorescent microscopy system for correlative workflows.

 EM: Electron microscopy 

 FIB: Focused Ion Beam

 HD View: A Microsoft Research image data format used for gigapixel-resolution 
image data.

 Holder Calibration: This procedure is used to adjust the expected fiducial positions 
for automated holder alignment on individual systems. It must be performed the first 
time alignment is run on a supported holder. See the “Automated Holder Alignment” 
on page 168 section on Calibration.

 Image Registration: The computational process Maps uses to determine the position 
of a single tile within the greater tile set. The Image Registration process is run during 
tile set acquisition.

 Live Acquisition (LA): The CorrSight platform software.

 LM: Light microscope

 LM: Low Magnification mode on TEM.

 Maps Offline Viewer: A version of Maps that has read-only capabilities for Maps 
projects.

 MIP: (CorrSight only) Maximum intensity projection. Collapses a Z-Stack of images 
into a single image using the highest intensity pixels from the stack.

 Nav-Cam: Navigation Camera

 SDB: Small DualBeam; a family of microscopes that have both scanning electron and 
ion columns.

N
O

T
E When upgrading from version 1 or 2 of Maps, a new license key is required to use 

Maps 3. 
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 Segmentation: In the context of images, segmentation is the process of assigning a 
label to specified pixels in an image such that pixels with the same label share certain 
visual characteristics, such as color.

 SEM: Scanning Electron Microscope

 Stitching: The computational task of combining a set of individual images to form a 
single image.

 STEM: Scanning Transmission Electron Microscopy. STEM mode exists on SEMs, 
SDBs and TEMs (depending on the exact configuration).

 TEM: Transmission Electron Microscope

 TIA: On TEM, the instrument user interface consists of two parts: TEM User 
Interface for instrument control and TEM Imaging and Analysis for acquisition and 
analysis.

 Tile Acquisition: The automated task of acquiring, aligning, and registering tiled 
images, as defined by the user.

 Tile Grid: The empty grid that defines where and how a set of tiles will be acquired.

 Tile Set: The output of a tile grid once acquisition is run, or the set of actual tiled 
images.

 xT Software: Platform software for the SEM/SDB microscopes.

 xT UI: xT software user interface

 Z-Stack: A sequence of images through the z-axis, used to build a 3D volume.

 Z-Stack Browser: The Maps UI component that allows you to view and select image 
planes from a z-stack.

System Requirements
 3 GB of physical RAM

 4.5 GB of memory paging allocated in Windows®

 Dual-core processor

 For Microscope Operation, microscope system software (xT, TEM Server, or LA) 
must be running before launching Maps

Data Storage Requirements
You may need additional internal or external storage capacity to acquire large tile sets. 
You will be prompted to select a default location for project data. It is suggested that you 
place the Project Data Directory on the D drive or a supplemental data storage device such 
as a network drive, external USB drive, or additional internal hard drive. Acquisition 
speed may be reduced when saving project data to USB or network locations.
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The table below indicates the number of tile sets you will be able to acquire at various 
image resolutions and dimensions, provided that the Project Data Directory is configured 
to save to a standard empty 350 GBD drive partition.

 

Project Directory
At the root directory, you will see the following:

The LayersData folder contains a directory structure that mimics the Layer tree in Maps, 
so you can manually locate the image files. 

Table 1    Data Storage Requirements for Single Channel Image Acquisition

Resolution Tile Set Size

5x5 10x10 50x50 100x100

512 15 MB 100 MB 1.25 GB 5 GB

1 K 55 MB 200 MB 5 GB 20 GB

2 K 200 MB 700 MB 20 GB 75 GB

4 K 750 MB 2 GB 75 GB 250 GB

8 K 4 GB 10 GB 250 GB 1.00 TB

Color Key:

Red < 1 Tile Set

Orange 1 to 2 Tile Sets

Yellow 2 to 5 Tile Sets

Green > 4 Tile Sets

N
O

T
E For multiple channel acquisitions, the storage requirements will increase incrementally 

with the number of channels.
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Launching Maps from a New File in the Project Directory
Double-click Project.mapsxml to launch Maps and automatically open the project from 
the directory in which this mapsxml file exists.

Package Options
This manual covers all options available with the Maps software. The About box lists the 
licensed options as determined by your product license key.

Contact your Thermo Fisher representative for licensing information.

Table 2    Maps Licensed Options (1 of 2)

Option Description

Big Snapshot Licensed to acquire high resolution square images (4k and 8k) on supported xT 
microscopes.

xT Online Licensed to run on the xT family of SEM and SDB microscopes, such as Helios 
NanoLab™, Quanta™, Versa, etc.

LA Online Licensed to run on CorrSight LM.

TEM Online Licensed to run on TEM family of microscopes, such as Titan, Talos, etc.

Array Tomography Licensed to enable the Array Tomography workflow. 

Annotations Licensed to create annotations in the project.
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Project Editing Licensed to edit projects. Without this projects are opened read-only.

External Image Import Licensed to allow importing of images from any source (for example, other 
microscopes, cameras, CAD exports, etc.)

Stage Correlation Licensed to allow 1–3 point alignment.

Color Correlation Licensed to allow correlation features including segmentation and color maps.

Stitching Licensed to allow stitching of acquired tile sets.

Array Tomography Licensed to enable features involved with the Array Tomography use case. 

Maps Offline Viewer Installations of Maps Offline Viewer are licensed only for viewing datasets that 
have been generated by the full version of Maps.

Table 2    Maps Licensed Options (2 of 2)

Option Description
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2 User Interface

Overview
This document describes the Maps 3.3 application software user interface.

Topics include:

 “Default Shortcut Keys” on page 10

 “Viewer Shortcut Keys” on page 11

 “Main Screen” on page 13

 “Menus” on page 15

 “Tool Bar” on page 30

 “Layer/Holder Definition Control (SEM/SDB and CorrSight Only)” on page 33

 “Tile Set Tab” on page 33

 “Results Tab” on page 34

 “Layer Control” on page 41

 “Job Queue” on page 49

 “Viewer” on page 51

 “Rotation Control in the Viewer” on page 60

 “Micron Bar” on page 60
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Default Shortcut Keys

Table 1    Shortcut Keys

Keys Description

F1 Opens the Maps 3.3 SW Application User Guide.

F2 Saves the screenshot with an automatically incremented file name. Same as 
selecting File > Save Screenshot. See “Save Screenshot” on page 19.

Space View all objects (zoom out).

Ctrl+Shift+C Centers the view on the current layer, same as “Center View on Selection” on 
page 32 and “Center View” on page 44.

Ctrl+G Shows/hides grid lines for the current layer, same as “Show Grid Lines” on page 47 
(Tile Set right-click menu selection).

Ctrl+H Hides all graphic elements in the viewer, leaving only the images. Same as selecting 
Options > Hide Annotations. See “Hide All Annotations” on page 27.

Ctrl+L Opens the Log Viewer. Same as selecting Help > Open Logs. See “Open Logs” on 
page 29.

Ctrl+O Opens the project folder. Same as selecting File > Open Project Folder. See 
“Open Project Folder” on page 19.

Arrows Moves selected tile set in small increments.

Shift + arrow Moves selected tile set in finer increments. 

Ctrl + left-click or drag Selects tiles.

Shift + left-click Selects tiles by row.



User Interface ■ Viewer Shortcut Keys

P N  1 1 4 8 9 1 3 - A  ■ 1 1 / 0 3 / 1 7 11

Maps 3.3 User GuideFEI CONFIDENTIAL, Limited Rights Data

Viewer Shortcut Keys
There are three profiles defined for Viewer’s shortcut keys (Application settings).

 “Default Profile” on page 11

 “Classic Maps Profile” on page 12

 “Avizo Profile” on page 12

Default Profile

Table 2    Viewer Default Profile Shortcut Keys

Keys Description

Ctrl + mouse wheel +/- Zooms in and out. 

Mouse wheel Zooms in and out slowly. 

Shift + Ctrl + left-click 
and drag

Zooms the image to the selected region. 

Left-click and drag Pan (move)

Shift + left-click and 
drag

Rotates the viewer without moving the stage. 

Alt + left-click and 
drag

Draw a feature of interest rectangle with a number of available options. See 
options. See “Alt +Left-Click and Drag Selected Area” on page 52.

Left-click Selects an object.

Ctrl + left-click Selects multi objects.

Escape Deselects all objects.

Shift + left-click Selects tiles by row.
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Classic Maps Profile
This profile defines the input as in previous Maps 2.5 version.

Avizo Profile
This profile defines the input as in Avizo® software.

Table 3    Viewer Classic Maps Profile Shortcut Keys

Keys Description

Ctrl + mouse wheel Zooms in and out. 

Shift + mouse wheel Zooms in and out slowly. 

Shift + Ctrl + left-click 
and drag

Zooms the image to the selected region. 

Shift + left-click and 
drag

Pan (move)

Shift + right-click and 
drag

Rotates the viewer without moving the stage. 

Left-click and drag Draw a feature of interest rectangle with a number of available options. See 
options. See “Alt +Left-Click and Drag Selected Area” on page 52.

Left-click Selects an object.

Ctrl + left-click Selects multi objects.

Table 4    Viewer Classic Maps Profile Shortcut Keys

Keys Description

Ctrl + middle-click and 
drag

Zooms in and out. 

Mouse wheel Zooms in and out slowly. 

Shift + Ctrl + left-click 
and drag

Zooms the image to the selected region. 

Middle-click and drag Pan (move)

Left-click and drag Rotates the viewer without moving the stage. 

Ctrl + Left-click and 
drag

Draw a feature of interest rectangle with a number of available options. See 
options. See “Alt +Left-Click and Drag Selected Area” on page 52.

‘”P” + Left-click Selects an object.

Ctrl + left-click Selects multiple objects.
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Main Screen
Figure 1 shows the main user interface.

Figure 1     Maps User Interface, Control Panel Showing

Menus, see page 15

Layer 
Control, 
see 
page 41

Tool Bar, see page 30

Tile Set 
Tab, see 
page 33

Viewer, see page 51

Hide 
main 
controls, 
see 
page 14

Microscope connection status, see page 14

Stage Rotation, see page 107

Scan Rotation, 
see page 107

Micron Bar, 
see page 51
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Show/Hide Main Controls 
Click the last icon on the left side of the tool bar to hide the main controls. Click the icon 
again to show the main controls.

Microscope Connection Status
The green dot in the lower right corner indicates that the application is connected to the 
microscope. Hover the mouse over the green dot to see a tool tip Connected to 
Microscope. 

 If the application is started with no microscope, the dot will be red to indicate offline 
mode.

 If Maps is unable to connect to the microscope, verify that the microscope control 
software is running and restart Maps.
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For the CorrSight, the yellow dot indicates that the microscope is trying to connect.

Interface Button States

 Enabled: White text on dark background

 Disabled: Gray text on darker background

Menus
Topics include:

 File, below

 “Microscope Menu” on page 88

 “Options” on page 22

 “Help” on page 28

File 
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Table 5    File Menu Overview (1 of 4)

Menu Selection Description

New Project Displays the New Project window. Define a new Project Name and Description and 
click Create.

See “New Project” on page 64.

Open Project Displays the Project History window showing all previous projects. The 
exclamation icon and a grey project title in italics indicates that the current project 
is not available (on a removable device).
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Open Project (Cont.) • Click New Project to access the New Project window for creating a new 
project.

• Click Import Project to display the Import Project window for importing a 
project. This is the same functionality as selecting File > Import Project.

• Click Open Project to select an existing project.

• Click the down arrow menu of the selected project to view two submenus: 
Open Project Folder and Remove Project...

• Click Refresh to refresh the status of the project list (e.g., Project not found).

• Double-click on a thumbnail to select an existing project.

• Click the List View icon to switch to a list view of projects.

• Right-click a project name in the list view to access the submenu for opening a 
project folder and removing a project.

• See “Open Project” on page 66.

Table 5    File Menu Overview (2 of 4)

Menu Selection Description
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Import Project Displays the Import Project window. Browse to a Source directory and select a 
project, rename it if appropriate, and then click Import. The imported project name 
will appear in the Project History list. This can be used for passing projects between 
computers.

Import Project (Cont.) Note: The import process is only one-way. Older software projects must be 
converted. When a project is imported from Maps v1.1 and 2.0, a warning is 
displayed telling the user that the import is one-way and the project will no longer 
be compatible with v1.1 and 2.0.

See “Import Project” on page 67.

Project Properties Displays the Project Properties window for selecting the Project Path, Sample 
Holder, and a project description. See “Project Properties” on page 20.

Table 5    File Menu Overview (3 of 4)

Menu Selection Description
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Open Project Folder

(Ctrl+O)

Displays the project folder. This can also be accessed by selecting Open Folder in 
the Project Properties window.

Save Screenshot As Displays a standard Windows Save As dialog box for saving a screen capture of the 
Maps viewer. Used for selecting a file name and a file type for saved viewer 
screenshots.

Save Screenshot

(F2)

Saves the screenshot with an automatically incremented file name. Briefly displays 
a dialog box with the saved (automatically incremented) file name. 

Quit Closes the Maps software.

Table 5    File Menu Overview (4 of 4)

Menu Selection Description
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Project Properties

View the attributes of the current project and modify the selected sample holder and 
project description here.
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Table 6    Project Properties Overview

Interface Item Description

Project Name Displays the name given to the project.

Project Path Displays the folder and location of the selected project.

Open Folder Displays the project folder. This can also be accessed by selecting File > Open 
Project Folder.

Disk Space Usage Displays the amount of disk space used by the project.

Total Number of 
Images

Displays the number of tiles and imported images for the project.

Sample Holder Displays a dropdown list of possible sample holders that support automated 
alignment on SEM/SDB or CorrSight microscopes.

Make a selection and then click Apply to see the holder outline displayed on the 
main screen. See “Sample Holders” on page 157 for more information.

Project Description Displays the description of the current project.

OK Applies the selections and closes the window.

Apply Applies the selection only.

Cancel Cancels any changes to the Project Properties and closes the window.
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Sample Holders

When a holder is selected and applied to the project:

 The outline displays in green on the viewer. The holder outline is red until it is 
aligned.

 The name, drawing, version, etc. display on the Holder tab.

 A new Layer is added to the Layer Control. This is where you choose to show or hide 
the Holder outline and Fiducials. The Fiducials only show after image acquisition. 
The default is to not show them. Enable the check box to view your fiducial images.

Refer to your application specialist for procedural information for each sample holder 
type.

Options

System Views

The common selections are described in the following table. For system-specific 
selections, see:

 SEM/SDB: “Options Menu” on page 89

 CorrSight: “Options Menu” on page 113

 TEM: “Options Menu” on page 135
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Figure 2     Options Menu, Specific Selections by System

SEM/SDB View CorrSight View

TEM View
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Table 7     Options Menu, All Selections Overview (1 of 4)

Menu Selection Description

Application Settings: Displays the Application Settings window for changing defaults for all new 
projects.

Default Project Data 
Directory

Displays the default path with a browse button to allow you to choose a different 
path.

Stage cursor color Click the browse button to access the Color picker to optionally change the stage 
cursor color.

Display 360° Scan 
Rotation

• When selected, displays 360° scan rotation.

• When not selected, displays –180° to 180° scan rotation.



User Interface ■ Menus

P N  1 1 4 8 9 1 3 - A  ■ 1 1 / 0 3 / 1 7 25

Maps 3.3 User GuideFEI CONFIDENTIAL, Limited Rights Data

Input Viewer Profile Displays a dropdown list of viewing choices.

Choices are: 

• Default: See “Default Profile” on page 11 for detailed inputs.

• Avizo: The inputs defined for the viewer are based on Avizo/Amira® 
software. See “Avizo Profile” on page 12 for detailed inputs.

• Classic Maps: The inputs defined for the viewer are based on the previous 
Maps version (v2.5). See “Classic Maps Profile” on page 12 for detailed 
inputs.

Stitching Profile Displays a dropdown list of stitching choices.

Choices are: 

• Default: The settings in this profile are intended for stitching a broad range 
of samples. One should generally start with this profile.

• Natural Structures: This profile is intended for life science or geology 
samples. The main difference with the default profile is more tolerance in its 
assessment on alignment validity. Use this profile if the default settings mark 
too many tiles as invalid while the alignment is OK.

• Repetitive Structures: This profile is intended for stitching of electronic 
devices, wafers, or repetitive structures. These settings force the algorithm to 
be more sensitive to edges and uses a different method of assessing alignment 
validity (as repetitive structures may mislead the image recognition 
algorithms). 

• No Stitching: The profile will not attempt to align the images. This will 
prevent any kind of stitching. Use this to save CPU resources when stitching 
is not desired, or if stitching will be done by another application.

See “Stitching Profile Best Practices” on page 27.

Table 7     Options Menu, All Selections Overview (2 of 4)

Menu Selection Description
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Default Holder Displays a pulldown list of possible sample holders. Select a holder to be used as 
a default for all new Maps projects.

Histogram white tail Trims a percentage of histogram pixels to eliminate noise.

Histogram black tail Trims a percentage of histogram pixels to eliminate noise.

Tile Set Templates: These are system-specific:

• SEM/SDB: “Tile Set Templates:” on page 90

• CorrSight: “Tile Set Templates:” on page 113

• TEM: “Tile Set Templates:” on page 136

Microscope Settings: These are system-specific:

• SEM/SDB: “Microscope Settings:” on page 90

• TEM: “Microscope Settings” on page 137

Snapshot Settings: SEM/SDB: See “Options Menu, SEM/SDB Overview” on page 90

Do Not Change Lens 
Mode

SEM/SDB: See “Do Not Change Lens Mode” on page 92.

Snapshot Settings TEM: See “Snapshot Settings” on page 138.

Prefer scan rotation If there is viewer rotation when creating a new tile set, the rotation will either be 
applied as stage rotation or scan rotation.

• When selected: Uses scan rotation.

• When not selected: Uses stage rotation. 

Stitch Tile Sets When 
Done

Automatically adds a stitching job to the end of the job queue for each completed 
acquisition job. 

Turn Off Beam When 
Done

SEM/SDB: See“Turn Off Beam When Done” on page 92.

Retract Detectors when 
Done

SEM/SDB: See “Retract Detectors when Done” on page 92.

Table 7     Options Menu, All Selections Overview (3 of 4)

Menu Selection Description
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Stitching Profile Best Practices
 Start with the Default profile and only change it if the default settings are not working 

well enough. 

 Before starting a large job, to do a few small runs (e.g., 4 x 4 tiles) and visually 
inspect the result to find out what the best profile and acquisition settings are. Then 
use the same acquisition setting on the small runs as on the large run. 

 If neither profile gives satisfactory results, try to improve the image quality via the 
acquisition settings; high quality image data has better chance to be successfully 
stitched. On SEM, consider using larger dwell times as higher image quality may 
reveal small features that facilitate image recognition

 If the image data is highly repetitive or very sparse, use a tile size such that there are 
enough distinct features present in each tile.

Sleep When Done SEM/SDB: See “Sleep When Done” on page 92.

Pump to HiVac When 
Done

SEM/SDB: See “Pump to HiVac When Done” on page 92.

Close Column Valves 
when Done

TEM: See “Close Column Valves When Done” on page 138.

Switch off Emission 
when Done

TEM: See “Switch off Emission when Done” on page 27.

Hide All Annotations

(Ctrl+H)

Hides all graphic elements in the viewer, leaving only the images. 

Show Layer name 
Annotations

Displays an additional annotation of the tile set names to help identify data during 
viewing.

Animate Pan & Zoom Allows a smoother transition of panning and zooming. Note that this is a slower 
process and takes more memory.

• Pan: To make a sweeping movement

• Zoom: To simulate movement rapidly away from or toward a subject using a 
zoom lens

Avizo Settings See “Maps-Avizo/Amira Connectivity Bridge” on page 213.

Table 7     Options Menu, All Selections Overview (4 of 4)

Menu Selection Description
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 When the success rate of the alignment is not sufficient, try to look at it from an image 
recognition point-of-view: the algorithm looks at the pixel data in the overlapping 
border regions; if there are not enough distinct features in that area, the alignment is 
very difficult. Also think about ambiguity. For example, if the overlapping area only 
contains a horizontal line, the vertical alignment is trivial but horizontally any position 
is a valid solution. The tile size, overlap, or the image resolution may need to be 
increased in order to get data that aligns well.

 On SEM/SDB, recommended overlap for systems with a mechanical stage (e.g., 
Quanta FEG):

— HFW > 50 µm overlap: 10%

— HFW 20–50 µm overlap: 15%

— HFW < 20 µm overlap: 20%

If stitching is still unsuccessful, consider increasing the overlap even more.

 On TEM, recommended overlap:

— Low Magnification: 20%

— Magnification 3000x–50000x: 10%–15%

— Magnification > 50000: 15%–20%

Help

N
O

T
E

The amount of required overlap is strongly related to how well the system is aligned.
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Table 8    Help Menu Overview

Menu Selection Description

User Manual (F1) Displays a PDF of this user guide.

Generate Bug Report Displays the Bug Report dialog used to generate a bug report.

Enter a description of the issue, your name, and email address. Then click Generate 
Report. The Bug Report folder will automatically open. The Maps development 
team will contact you if more details are needed.

Open Bug Report 
Folder

Displays the folder where the generated bug reports are stored.

Open Logs 

(Ctrl+L)

Displays the Log Viewer.

About Displays the About box with information about the software versions and a list of 
installed licensed options. For descriptions of the options, see “Package Options” 
on page 7.
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Tool Bar
The common selections are described in the following table. For system-specific 
selections, see:

 SEM/SDB: “Tool Bar, Right Side” on page 93

 CorrSight: “Tool Bar, Right Side” on page 114

Topics in this section include:

 Left Side, All Systems, below

 “Secondary Menu” on page 30

 “Tool Bar Descriptions” on page 31

Left Side, All Systems

Secondary Menu
If the window is resized too small to display all tools, some of them are stored in a 
secondary menu. Click the down arrow to access them.

Figure 3     Tool Bar, Left Side, All Systems

Move & 
Resize Tool

Measurement 
Tool

Go to 
Microscope 
FOV

Center View 
on Sample

Global 
Alignment

Align to Holder 
(not for TEM)

Save 
Screenshot (F2)

Stitch 
Selection

Zoom to 
Selection

Add Tile Set

Add Circular 
Tile Set

Add Freehand 
Tile Set

Add Area of 
Interest

Save Image 
to File

Center View 
on Selection
(Ctrl+Shift+C)

Angle 
Measurement 
Tool
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Tool Bar Descriptions

Table 9    Tool Bar Descriptions (1 of 2)

Tool Description

Move & Resize Tool Moves or resizes the tile grid with click and drag.

Measurement Tool Draws a line and displays the length as a callout.

Angle Measurement Tool Draws a line and a third point; displays the angle as a callout.

Zoom to Selection Zooms the field of view to the selected area.

Add Tile Set Adds a tile set over a selected area in the viewer.

Add Circular Tile Set Adds a circular tile set over a selected area in the viewer.

Add Freehand Tile Set Adds a freehand drawn tile set over a selected area in the viewer.
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Add Area of Interest Displays the New Annotation dialog box for adding the drawn selected area 
of interest (AOI). 

The new AOI becomes a new Annotation layer in the Layer control. 

Save Image to File Saves an image to file. See “Save Image to File” on page 69.

Stitch Selection Stitches a subset of tiles, as selected by the rectangle. See “Stitching” on 
page 99.

Center View on Sample Zooms out to the full sample view. 

Center View on Selection

(Ctrl+Shift+C)

Disabled until a project is open. 

Pans & zooms the viewer so that the currently selected layer item is centered.

Go to Microscope FOV Pans and zooms the view to match the microscope (electron beam) field of 
view (FOV).

Save Screenshot (F2) Briefly displays a dialog box with the saved (automatically incremented) file 
name. Also available from File > Save Screenshot.

Global Alignment Performs a 1-, 2-, or 3-point alignment to align all previously acquired data 
to the stage. It is useful if the sample was removed from the tool and you 
want to continue with it. See “1-, 2-, or 3-Point (Coarse) Alignment” on 
page 196.

Align to Holder

(SEM/SDB and 
CorrSight only)

Performs an Automated Holder Alignment; requires a specific holder 
hardware. 

If no sample holder has been selected for the project, a dialog box appears to 
prompt you to select a holder.

See “Automated Holder Alignment” on page 168.

Table 9    Tool Bar Descriptions (2 of 2)

Tool Description
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Layer/Holder Definition Control (SEM/SDB and CorrSight 
Only)

 SEM/SDB: See “Layer/Holder Definition Control” on page 94.

 CorrSight: See “Layer/Holder Definition Control” on page 115.

Tile Set Tab
When you create a new tile set, the parameters for basic tile acquisition are populated with 
defaults. Information is grouped by category and opened by clicking the down arrow.

The selections are system specific:

 SEM/SDB: “Tile Set Tab” on page 95

 CorrSight: “Tile Set Tab” on page 116

 TEM mode: “Tile Set Tab, TEM Mode” on page 140

 STEM mode: “Tile Set Tab, STEM Mode” on page 144

This example shows 
the SEM/SDB version.
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Results Tab
Use the controls on this tab to apply simple coloring to the tile set images when acquired 
and to do post processing functions. Some controls will appear disabled if they are not 
applicable to the system type. See “Correlation” on page 202 for more information.

Topics in this section include:

 “Results Tab Overview” on page 35 

 “Post Processing Group” on page 35
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Post Processing Group

Table 10    Results Tab Overview

Control Description

Opacity Sets the measure of opaqueness for the entire image. The less opaque, the more 
transparent it becomes. Transparent images are useful when overlaying on image 
over another.

Show Histogram Panel Shows/hides the histogram panel. See “Histogram” on page 206.

Channels 

• Channel color selector: Enables display of that channel. Shows the name and 
color.

• Opacity slider: Adjusts opacity for this channel only.

• Gamma: Displays the gamma curve adjustment.

• Reset: Resets the Gamma slider to the default.

• Color picker: Displays the color picker. Choose a unique color for each 
channel to display in the histogram.

• Add Color: Launches Segmentation. Displays an additional histogram every 
time you click the button. See “Segmentation” on page 208.

Table 11    Results Tab, Post Processing Group Overview

Control Description

Stitch Stitches the entire tile set.

Split Channels Divides the individual channels of a tile set into separate tile sets. Note: This 
operation is permanent and cannot be undone. 

Create MIP Layer Collapses the Z-stack into a single image using the highest intensity pixels from the 
stack.

Reset Acquisition Clears all acquired image data in the selected tile set and unlocks the parameter 
fields in the Basic tab for editing.

Open Z-Stack

(SEM/SDB and 
CorrSight only)

Opens the Z-Stack Browser to view the focus stack of the tiles. See“Z-Stack 
Browser Controls” on page 36.
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Z-Stack Browser Controls

The Z-Stack Browser allows you to select and view individual image planes in the Z-
Stack.

After acquiring a Z-stack tile set, right-click on a single tile in the tile set and then click 
Open Z-Stack in the menu that appears.

Figure 4     Z-Stack Data Set in Viewer Before Opening Z-Stack Browser
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The Z-Stack Browser appears on the right-side of the interface. 

Figure 5     Z-Stack Browser Open with Controls on the Right
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Z-Stack Browser Controls

Figure 6     Z-Stack Browser Controls

Table 12    Z-Stack Browser Controls Overview (1 of 3)

Interface Item Description

Channel Selector Selects the channel to be displayed in the multi-channel Z-Stack. The pulldown list 
contains the same choices as in the Microscope controls. 

Histogram Displays the same histogram as in the Microscope controls. See “Histogram” on 
page 206.

Close Closes the Z-Stack Browser.

Tile Set View

Plane Selector

Gamma Control

Histogram

Close
Channel Selector
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Plane Selector Selects the plane from the Z-Stack to be displayed with the channel selection. Move 
the slider or use the mouse scroll wheel to step through the planes. 

Current Plane Control:

Select for Display Selects the plane to be displayed in the main viewer after you close the Z-Stack 
Browser. Note: Only one plane can be displayed in the main viewer.

Select for Stitching Selects the current plane to be used for the registration step for stitching. Choosing 
a plane with more image content is best.

Reset Returns to the default gamma setting.

Go To Sets the microscopes current focus to the value in the z stack viewer control.

Gamma Control Adjusts the gamma for the live image.

Table 12    Z-Stack Browser Controls Overview (2 of 3)

Interface Item Description
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Tile Set View Displays the selected tile (with a thick green outline) from the main viewer and its 
neighboring tiles. 

Table 12    Z-Stack Browser Controls Overview (3 of 3)

Interface Item Description
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Layer Control
Use the controls to view existing layer items and create, delete, reorder, select, hide, and 
show layers. When a check box is not selected, that layer item will not be displayed in the 
viewer.

Double-click on an item in the Layer control to center it in the viewer. Topics in this 
section include:

 “Layer Icons” on page 42

 “Running Layer Tasks Progress” on page 43

 “Annotation Right-Click Menu” on page 43

 “Layer Right-Click Menu” on page 44

 “Tile Set Right-Click Menu” on page 46

 “Preview Image Right-Click Menu” on page 48

 “Nav-Cam Right-Click Menu” on page 49

Table 13    Layer Control Overview (1 of 2)

Control Description

Active Template Displays the name of the default template for the connected microscope.

Add Layer Adds another Layer to the tree. When you have multiple layers, the selected layer 
will be green and the non-selected layers will be yellow.

Add Tiles Creation of a tile set is only allowed if a microscope is connected. In that case, the 
tile set will use the type corresponding to the microscope, and the template 
specified in the Active Template field.
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Layer Icons
Each created layer item has a unique icon.

Layer Displays a list of existing tile sets, annotations (areas of interest), imported images 
(aligned and unaligned), sample holder, and fiducials for each layer.

See “Layer Icons” on page 42.

Annotations are directly created in the layer selected at the time of creation.

Figure 7     Layer Control Icons

Table 13    Layer Control Overview (2 of 2)

Control Description

Text Callout: Annotations

Holder Outline: 
Graphic Outline of Holder

White Crosshair: Fiducials 

Photo Frame: 
Imported Image, Aligned 
and Stitched to Project

Red Crosshair: 
Imported Image, 
Not Yet Aligned 

Green check box: 
Tile set Registration and 
Acquisition completed
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Running Layer Tasks Progress
 Acquisition progress is reported in the “Job Queue” on page 49.

 Registration progress is reported by hovering the mouse over the tile set symbol.

When both Registration and Acquisition have completed, a green check mark appears in 
the Tile set icon.

Annotation Right-Click Menu
Right-click on an Annotation in the Layer tree to access a context menu for moving the 
annotation layer forward or backward, centering and rotating the view, driving to, and 
deleting.

All of these menu selections, except Drive To, are common to most all other layer item 
context menus.

Table 14    Annotation Right-Click Menu Overview (1 of 2)

Menu Selection Description

Bring to Front Moves the (annotation) layer to the front (topmost) layer.

Bring Forward Moves the (annotation) layer forward one layer.

Send Back Moves the (annotation) layer back one layer.

Send to Back Moves the (annotation) layer to the lowest layer.

Unique selection for Annotation.
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Layer Right-Click Menu
Right-click on any Layer selection to access a context menu. 

 For descriptions of common selections to all systems, see “Annotation Right-Click 
Menu” on page 43.

 For descriptions of Layer-specific selections, see the table below.

Center View

(Ctrl+Shift+C)

Centers the view on the created (annotation).

Center and Rotate 
View

Pan, zooms, and digitally rotates the viewer so that the currently selected 
(annotation) is centered and shown at its natural rotation. 

Drive To Drives to the created annotation.

Delete Deletes the created (annotation).

Table 14    Annotation Right-Click Menu Overview (2 of 2)

Menu Selection Description

Unique selections for Layer.
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Table 15    Layer Right-Click Menu Overview

Menu Selection Description

Copy Layer Copies all tile sets in the layer to a new layer.

Import Grid Displays a standard Open window for browsing to a saved tile grid file.

Import Image Displays a standard Open window for browsing to a saved image file from another 
source, such as an optical microscope. 

These images, once aligned to the stage, can provide a navigation guide for you to 
find areas of interest, like the Nav-Cam does.

See “Importing Images from Other Sources” on page 77.

Import HD View Displays a standard Browse window for selecting an HD View image to import into 
Maps. 

Alignment: Displays a submenu of alignment choices. See “Aligning a Tile Set and Its 
Magnification” on page 149.

Align Aligns a single tile set or image. Similar to Global Alignment, but for a single item. 
See “1-, 2-, or 3-Point (Coarse) Alignment” on page 196.

Fine Alignment Use Fine Alignment to fine-tune the alignment of layers and tile sets visually. The 
Fine Alignment controls only display after clicking Next after a 1-, 2-, or 3-point 
alignment.

See “Fine Alignment” on page 200 for descriptions of the controls.

Clear Alignment Clears any tile set alignment that has been applied in Maps.
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Tile Set Right-Click Menu
Right-click on any tile set to access a context menu. 

 For descriptions of common selections to all systems, see “Annotation Right-Click 
Menu” on page 43.

 For descriptions of Tile Set-specific selections, see the table below.

Unique selections for Tile Set.
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Table 16    Tile Set Right-Click Menu Overview

Menu Selection Description

Reset Acquisition Clears all acquired image data in the selected tile set and unlocks the parameter 
fields in the Basic tab for editing.

Show Grid Lines

(Ctrl+G)

Toggles to show/hide the tile grid lines onscreen. 

Save As Default 
Template

After editing the defaults, saves the edits as the new default template.

Save As Template Displays a submenu New Template, that allows saving the current tile layers 
template as a new template or overriding a previous template.

Copy Grid Creates a grid above the one that is copied, and incrementally numbers the name. In 
this example, EMTileSet 5 is a copy of EMTileSet 4.

Export Grid Displays a standard Save As window for browsing to a folder in which to save the 
exported grid.

Grids are saved in the *.gridx format.

Export to Project Copies the selected tile sets into a new or existing Maps project.

Alignment: Displays a submenu of alignment choices.

See “Alignment:” on page 45 for descriptions.

Drive To Drives to the selected tile set.

Apply Settings to 
Microscope

Applies all defined tile set settings to the microscope.

Apply Microscope 
Settings to Grid

Applies all microscope settings to the tile set.

Create MIP Layer Collapses the Z-stack into a single image using the highest intensity pixels from the 
stack. This menu selection is enabled for tile layers with more than one plane.

Split Channels Divides the individual channels of a tile set into separate tile sets. Note: This 
operation is permanent and cannot be undone. 
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Preview Image Right-Click Menu

Preview images are directly stored in the selected layer. Right-click on a preview image to 
access a context menu. 

 For descriptions of common selections to all systems, see “Annotation Right-Click 
Menu” on page 43.

 For descriptions of Preview Image-specific selections, see the table below.

Table 17    Preview Image Right-Click Menu Overview

Menu Selection Description

Export to Project Copies the data to a new or existing project.

N
O

T
E

This menu is SEM/SDB and CorrSight only.

Unique selection for Preview Image.
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Nav-Cam Right-Click Menu

The Nav-Cam image is stored in the selected layer. Right-click on a Nav-Cam entry to 
access a context menu. 

This is only applicable to SEM/SDB and CorrSight systems.

 SEM/SDB: See “Nav-Cam Right-Click Menu” on page 102.

 CorrSight: See “Preview Layer, Nav-Cam Right-Click Menu” on page 121.

Job Queue
Topics include:

 “Summary” on page 50

 “Floating Window” on page 50

 “Right-Click Menu” on page 51

N
O

T
E

This menu is SEM/SDB and CorrSight only.

Unique selection for Nav-Cam.
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Summary
The Summary is always visible in the status bar, and indicates the status of the current 
acquisition, when a job is running. The progress bar is relative only to the tile set being 
acquired.

When a job is not running, it looks like this.

Floating Window
The Job Queue is a floating window that appears when you click the arrow on the right.

To dismiss this window, click anywhere outside the Job Queue window.

Table 18    Job Queue Floating Window Overview

Control Description

Tile Sets selected for 
processing

Displays the list of selected tile set(s) for acquisition or stitching.

SELECT ALL Selects all jobs for acquisition or stitching.

DESELECT ALL Deselects all jobs for acquisition or stitching.

Show completed jobs Displays completed jobs for acquisition or stitching.

Job Processing Displays the percentage of progress for the acquisition or stitching 
process.

Up and Down Arrows Reorders the non-running jobs.

Remaining Time Displays the time remaining for processing.
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Right-Click Menu
Remove: Removes only the selected tile set from the job queue, if it is not already in 
process.

Viewer

Overview
This example shows a 4 x 4 tile set grid. 

 Double yellow lines indicate the overlap between tiles. 

 The purple FOV (field of view) rectangle displays the HFW (horizontal field width).

 The scale bar (not shown) in the bottom right corner shows the distance (e.g., in 
microns) in relation to the current magnification of the displayed image.

 The Delete key works in Maps for any selected item. You will receive a Confirmation 
request.

N
O

T
E

The coloring and labels of the FOV rectangle may change depending on the context.
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Topics in this section include:

 “Tile Set Grid Color Key” on page 52

 “Alt +Left-Click and Drag Selected Area” on page 52

 “Viewer Tile Right-Click Menu” on page 56

Tile Set Grid Color Key
 Yellow = Unacquired tiles. Visually indicates the tile overlap.

 Grey = Tiles that have been disabled; they will not be acquired

 Lime Green = Acquired tiles that are awaiting registration

 No outline = Acquired tiles that have been successfully registered

 Red = Acquired; but these tiles failed registration and will require manual alignment 
(see “Manual Alignment” on page 80)

 Bright Red =Edges of groups of red tiles are highlighted with a brighter red, to show 
where the actual break in the connection is. Often, fixing a bright red connection (via 
“Manual Alignment” on page 80) will allow previously red tiles to become 
successful.

Alt +Left-Click and Drag Selected Area
Alt+left-click and drag a rectangle in the viewer to create a selected area. A menu appears 
with selections for that area.
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‘

Table 19    Viewer Selected Area Overview

Menu Selection Description

Zoom to selection Zooms the field of view to the selected area.

Add tiles Places a new tile set in the selected area, using the Active Template. 

Add area of interest Places a new Annotation layer in the Layer control.

Save image to file Saves an image to file. See “Save Image to File” on page 54.

Stitch selection Stitches a subset of tiles, as defined by the rectangle area of interest. See 
“Stitching” on page 79. This menu item is disabled if no tile set is selected.
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Save Image to File

When you use Alt+left-click and drag to create a new tile set, the menu selection Save 
Image to File appears.

1. Click Save image to file. The Save Selection Options dialog box appears.

2. Enter a desired resolution (Export Image Width in pixels) or click Use Full 
Resolution to set the exported image width to the native pixel size.

3. Select the Add Scale Bar check box to place the viewer scale bar on the exported 
image.

4. Click the browse button (...) to display the browser window.

N
O

T
E Full resolution exports for large selections of high-resolution data are not available for all 

image types.
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5. File type options include TIFF Image and Tiled TIFF Image, and HD View. Select a 
file type, file name, and location and then click Save. 

There are limitations for the TIFF file type. If TIFF is desired, but the resolution of 
the selected area is too large for TIFF export, a warning appears and the exported 
image width in pixels will be automatically reduced to the maximum for TIFF 
export.

To save large resolution images, use the Tiled TIFF format.

N
O

T
E Not all image processing software supports the Tiled TIFF format. It is recommended to 

use the TIFF format to ensure compatibility with external image processing packages.
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6. The Save Selection Options window is still open. Click OK to close it.

Viewer Tile Right-Click Menu
Right-click on a tile within the tile grid to access a context menu.

Figure 8     Viewer Tile Right-Click Menu, All Systems

SEM/SDB TEM CorrSight
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The common selections are described in the table below. For system-specific selections:

 SEM/SDB: See “Viewer Tile Right-Click Menu” on page 103.

 CorrSight: See “Viewer Tile Right-Click Menu” on page 122

 TEM: See “Viewer Tile Right-Click Menu” on page 148.

Table 20    Viewer Tile Right-Click Menu Overview (1 of 3)

Menu Selection Description

Drive Stage Here Moves and centers the stage to the selected tile (see the green cross). 

Snapshot Here Acquires a preview image at the selected stage coordinate and current HFW.

Add Tiles Here Adds a new Tile Grid centered on the clicked location.

Add Site of Interest Displays a New Annotation dialog box for creating the Site of Interest (SOI). 
An SOI is a specific stage location used to mark sample features.

Z: Stage Z and T: Alpha Tilt can optionally be stored to be recalled later.

The new SOI is created is the currently selected layer group.

Note: This is different from the New Annotation dialog box for creating an 
Area of Interest, which marks an area of the stage. 

Acquire/Re-acquire • Acquire: Displays if the tile has not been acquired.

• Re-acquire: Displays if the tile has already been acquired.

Snap to stage position Moves the clicked position on the tile layer to the current stage position.

Clear Digital Rotation Resets the viewers digital rotation to 0 degrees.



User Interface ■ Viewer

P N  1 1 4 8 9 1 3 - A  ■ 1 1 / 0 3 / 1 7 58

Maps 3.3 User GuideFEI CONFIDENTIAL, Limited Rights Data

Add Site of Interest (Cont.) The new SOI becomes a new Annotation layer in the Layer control. Add 
notes and assign a color to display in the viewer.

Sample (SEM tiles in this 
example)

Displays the name of the selected tile set. 

The submenu has choices to: Preview Corners or Preview Edges.

Preview Corners After running Preview Corners, preview images appear in the corners of the 
tile set.

Table 20    Viewer Tile Right-Click Menu Overview (2 of 3)

Menu Selection Description
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Preview Edges After running Preview Edges, preview images appear in center of each edge 
of the tile set.

Tile X, Y Displays the row (X) and column (Y) number for the selected tile. 

Open Z-stack Opens the Z-Stack Browser to view the focus stack of the tiles. See“Z-Stack 
Browser Controls” on page 36.

Acquire/Re-acquire • Acquire: Displays if the tile has not been acquired.

• Re-acquire: Displays if the tile has already been acquired.

Snap to Stage Position Moves the tile to the current stage position.

Open Tile Image Folder Opens explorer to the directory holding the tile image data.

Open Source Image Opens the tile’s source image file with the default image viewer (Windows 
Picture Viewer). 

Preview Tile(s) SEM/SDB: See “Preview Tile(s)” on page 104.

TEM: See “Viewer Tile Right-Click Menu Overview” on page 57.

Sub-tile SEM/SDB: See “Sub-tile” on page 104.

Clear Digital Rotation Sets the digital rotation to zero if rotation had previously been applied. This 
only changes the displayed rotation of the images and does not rotate the 
microscope stage.

Auto-Rotate Viewer to FOV TEM: See “Viewer Tile Right-Click Menu Overview” on page 148.

Auto-Rotate Viewer to Tile 
Set

TEM: See “Viewer Tile Right-Click Menu Overview” on page 148.

Table 20    Viewer Tile Right-Click Menu Overview (3 of 3)

Menu Selection Description
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Rotation Control in the Viewer
Grab the lollipop-looking control with the mouse to easily rotate tile layers (not for TEM) 
and annotation layers.

Micron Bar
The micron (scale) bar scales to the magnification.
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3 Basic Operations

Overview
This chapter describes the basic process flow for Maps.

Topics include:

 “Launching the Application” on page 61

 “Nav-Cam Prompt (SEM/SDB Only)” on page 68

 “Creating a Project” on page 64

 “Setting Options” on page 70

 “Nav-Cam Alignment (SEM/SDB and CorrSight Only)” on page 71

 “Running the Automated Holder Alignment (SEM/SDB and CorrSight Only)” on 
page 71

 “Defining a Tile Set” on page 72

 “Acquiring a Tile Set” on page 76

 “Importing Images from Other Sources” on page 77

 “Stage Navigation” on page 78

 “Stitching” on page 79

Launching the Application
Click the desktop icon to launch Maps or use the Windows Start menu.
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Application Window
The application window displays with the Project History window open.

Select a display mode from the icons below New Project:

 Thumb View: Displays thumbnail images of project data.

 List View: Displays a list of project data.

New Project
If this is your first project, the list/thumb view will be empty and the Open Project button 
will be disabled. Click New Project and proceed to “New Project” on page 64.

Import a Project
To import a project that was created on another system and does not appear in the project 
list, click Import Project. The project opens and its name is added to the project history 
list. See “Import Project” on page 67.
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Open a Project
To open an existing project, highlight a project name in the list and click Open Project 
and then proceed to “Open Project” on page 66. 

Yellow Exclamation Mark in Project List
This symbol appears if the project path is not found for that data, due to a disconnected 
network drive, USB drive, or other drive.

Refresh
Updates the status of any disconnected projects that have been reconnected properly.

Quit Maps/Cancel
 If you have not opened a project yet, then you can directly quit Maps from the Quit 

Maps button. 

 If a project is already opened, then this button is replaced by a Cancel button that 
allows you to close the Project History window.
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Creating a Project
Create a new project, import a project, or open an existing project using File menu 
selections (page 15) or Project History buttons.

New Project
1. To create a new project, select File > New Project or File > Open Project, or click 

the New Project button from the already open Project History window.

2. In the New Project window that appears, define the new Project Name, and enter a 
brief Project Description. Then click Create.
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The default data directory will be used unless you browse to a new location.

The new project name appears in the title of the Layer control panel and the Layer 
control shows a default Layer.

The purple rectangle represents the current field of view on the sample and the 
purple + is the current stage position.

The white outline shows the stage boundaries, which can be circular or rectangular 
shaped depending on the instrument.

N
O

T
E

The Project Name cannot be empty.
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Open Project
To select an existing project, select File > Open Project or select a project name from the 
already open Project History window and click Open Project.
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The selected project name appears in the Layer control title.

Import Project
Importing a project is useful for passing projects between computers. Once imported, you 
can select it as an existing project.

1. To import (save) an existing project, select File > Import Project. 

2. Browse to a Source directory. Name the project to be exported and then click 
Import. 
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The imported project opens and the file name is added to the project 
history list.

Converting From Maps 1.1 or 2.0 SW

The import process is only one-way. Older software projects must be converted. When a 
project is imported from Maps v1.1 or Maps v2.0, a warning is displayed telling the user 
that the import is one-way and the project will no longer be compatible with the older copy 
of the software.

Nav-Cam Prompt (SEM/SDB Only)

When you first try to import from the Nav-Cam, the application will ask the user if it is a 
door-mounted Nav-Cam (see image below).

N
O

T
E

Nav-Cam is not supported for Maps on TEM systems.
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 If No is chosen, the Door-mounted check box on the Microscope Settings window is 
not automatically selected, but you have the option to select it manually. 

 If no Nav-Cam is installed, the check box is disabled. 

You will be prompted to browse to a default location for storing project data. 

It is recommended that you do not use the C: drive, but you can use a supplemental data 
storage device such as a network drive, external USB drive, or additional internal hard 
drive.
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Setting Options
Select new project defaults from the Options menu.

 Application Settings, below

 “TileSet Templates” on page 70

 “Microscope Settings” on page 70

 “Snapshot Settings (SEM/SDB Only)” on page 70

 “SnapShot Settings (TEM Only)” on page 70

 “Animate Pan & Zoom” on page 71

 “Nav-Cam Alignment (SEM/SDB and CorrSight Only)” on page 71

 “Running the Automated Holder Alignment (SEM/SDB and CorrSight Only)” on 
page 71

Application Settings
Select Options > Application Settings to display a window for setting defaults. See 
“Application Settings:” on page 24 for descriptions of the controls.

TileSet Templates
Select Options > TileSet Templates to display a dialog that shows a collection of 
templates and their respective settings. These are system-specific:

 SEM/SDB: “Tile Set Templates:” on page 90

 CorrSight: “Tile Set Templates:” on page 113

 TEM: “Tile Set Templates:” on page 136

Microscope Settings
Select Options > Microscope Settings to display the Microscope Settings window. 

These are system-specific:

 SEM/SDB: “Microscope Settings:” on page 90

 TEM: “Microscope Settings” on page 137

Snapshot Settings (SEM/SDB Only)
Select Options > Snapshot Settings to display the Microscope Settings window. See 
“Snapshot Settings” on page 91.

SnapShot Settings (TEM Only)
Select Options > Snapshot Settings to display the Snapshot Settings Window. See 
“Snapshot Settings” on page 138.
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Animate Pan & Zoom
Select Options > Animate Pan & Zoom to allow a smoother transition of panning and 
zooming. 

 Pan: To make a sweeping movement

 Zoom: To simulate movement rapidly away from or toward a subject using a zoom 
lens

Nav-Cam Alignment (SEM/SDB and CorrSight Only)
 SEM/SDB: See “Nav-Cam Alignment” on page 108.

 CorrSight: See “Nav-Cam Alignment” on page 129.

Running the Automated Holder Alignment (SEM/SDB and 
CorrSight Only)
 SEM/SDB: See “Automated Holder Alignment” on page 168.

 CorrSight: See “Automated Holder Alignment” on page 168.

N
O

T
E

This is a slower process and takes more memory.
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Defining a Tile Set
Topics include:

 Methods, below

 “Defining a Circular Tile Set” on page 73

 “Defining a Freehand Tile Set” on page 74

 “Tile Set Display with Grid” on page 74

 “Configure Tiling Parameters” on page 75

Methods
Define the tile set for your project using one of the three methods below:

 Click the Add Tiles button on the Layer control. 

 Or, press Alt+left-click and drag a rectangle in the Viewer and then select Add Tiles 
from the menu.
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 Or, click the Add Tile Set button in the tool bar, then click and drag an area in the 
viewer.

Maps creates a layer in the Layer control, depending on the type of microscope connected. 
You cannot create a tile set when not connected to a microscope.

The new name is added to the list of tile sets beneath Layer in the Layer control. The Tile 
Set tab displays default parameters, and a grid (green square) is centered on the stage 
location.

Defining a Circular Tile Set
Click the Add Circular Tile Set button in the tool bar, then click and drag an area in the 
viewer to create the tile set.

Example
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Defining a Freehand Tile Set
Click the Add Freehand Tile Set button in the tool bar, then click and drag an area in the 
viewer to create the tile set.

Example

Tile Set Display with Grid
 SEM/SDB View
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 TEM View

Configure Tiling Parameters
 Change the default tiling parameters to customize the grid for the data you will be 

acquiring. 

 Modify the imaging parameters and resize the grid for the level of detail and size you 
need.

N
O

T
E

This will look different in STEM mode.
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Acquiring a Tile Set 
When ready to begin acquisition, click Start Execution located in the status bar next to 
No Job.

Tile images are registered for stitching as they are acquired and displayed in the grid. The 
tile sets are colored as they are registered to give immediate feedback on the stitching 
confidence. See “Tile Set Grid Color Key” on page 52.
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Preconditions
Microscope preconditions must be met to proceed with tile set acquisition. For example, if 
the microscope is not enabled or an acquisition parameter is invalid, then a validation error 
appears in relation to the tile layer and you cannot start acquisition.

Importing Images from Other Sources
It may be useful to import an external image for navigation purposes to find the area of 
interest.

1. Right-click on a Layer in the Layer control and select Import Images on the context 
menu that appears.
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2. In the standard Open window that appears, browse to a saved image and then click 
Open. Most standard image formats are supported, including but not limited to: 
BMP, JPG, GIF, PNG, or TIFF images.

The imported image is displayed to the right of the main viewer while the alignment 
workflow is in progress. See “Manual Alignment” on page 195.

3. Align the two images with a simple one-, two-, or three-point alignment procedure: 
Move the alignment points on the imported image to match the feature on the tile set 
image and then click Next. See “1-, 2-, or 3-Point (Coarse) Alignment” on page 196 
for detailed information.

After clicking Next, the viewer is restored to full size and the newly imported image 
is displayed aligned to the stage. The imported image name is added to the Layers 
control.

Nav-Cam images (SEM/SDB and CorrSight) are automatically aligned, so this step 
can be skipped, although you may want to do a manual alignment for fine tweaking.

Stage Navigation
Double-click anywhere within the stage boundaries as shown by the white circle or square 
to move the stage to that location.
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Stitching
After a tile set with at least one tile has been acquired, the Stitch button is enabled.

Initiate Stitching
Select the acquired tile set in the Layer control and click Stitch in the Results Tab, Post 
Processing group. The manual UI immediately appears so you can confirm the tile 
alignments.
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Or left-click and drag a rectangle around the tile sets to be stitched and select Stitch 
Selection in the menu. 

Stitch selection will stitch all tiles inside the rectangle for the selected tile set. Tiles that 
are partially inside the rectangle are included as well. See “Alt +Left-Click and Drag 
Selected Area” on page 52.

Manual Alignment
Follow the guided instructions to confirm or edit the alignment of the tiles.
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Stitching Manual Alignment Histogram 

Displays the histogram for the Stitching Channel (see “Stitching Channel” on page 118). 

Figure 1     Stitching Manual Alignment Histogram

Table 1    Stitching Manual Alignment Histogram Overview

Interface Item Description

Channel name • For SEM/SDB: Displays the channel name, which is the detector name.

• For CorrSight: Displays the individual channel name as determined by the 
LM software.

Apply Applies changes to the histogram.

Auto When selected, continuously adjusts the min and max for the histogram display.

Semi-log When selected, changes the histogram intensity display to logarithmic.

Current Max position Displays the current max slider position.

Histogram data Displays the histogram data for the selected channel.

Current Min position Displays the current min slider position.

Current Max position

Histogram data

Current Min position

Max slider

Min slider

Channel name
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Overlap Transparency

Overlap Transparency options are available for assigning a color for the Center Tile and 
its Neighbor Tiles.

Transparency is useful for seeing through the layers to line up the tiles in manual tile 
alignment. 

Figure 2     Manual Alignment with Transparency Off

Click the down arrows to select a color

Tile Alignment View Project View
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Two Views

Manual stitching makes use of two views, see Figure 2, “Manual Alignment with 
Transparency Off,” on page 82: 

 The Tile Alignment View is the larger view:

This view displays the currently selected tile and it's top, bottom, left and right 
neighbors. The positions of the neighboring tiles are based on their individual 
registrations to the center tile. This is not the same as the final position when stitched, 
which will be a result of the optimization of all tile-to-tile registrations of the tile set. 
When manual alignment is first initiated, the first tile that failed alignment is selected 
and displayed here.

The view can be panned and zoomed in the same way as the other views. The center 
tile is fixed, but you can click left-mouse+drag to move its surrounding tiles.

 The Project View is the smaller version of the standard viewer in the bottom right:

This is a miniaturized version of the standard Maps project view. It can be panned, 
zoomed, and each tile can be selected with the mouse. When a tile is selected, it 
appears as the center tile in the Tile Alignment View, and it can then be manually 
aligned to it’s neighbors.

Figure 3     Manual Alignment with Transparency On

Tile Alignment View Project View
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Stitching Alignment Status Color Key

Each tile outline is colored to indicate stitching alignment status. 

 Green: The automatic tile alignment succeeded. 

 Orange: One side of the tile alignment failed, but another succeeded. These tiles do 
not require manual alignment. 

 Red: The tile failed to align with either neighbor, which means that there is not 
enough valid registration for a tile or one of its neighboring tiles to be properly 
positioned in the larger picture. Often multiple tiles can be red, but only one tile needs 
to be manually connected to the green tiles to achieve alignment for all. After 
realignment, the outline turns blue.

Realign Failed Tiles

Use the Next and Previous buttons to jump through the list of failed tiles easily. 

Confirm and Stitch

When manual alignment is finished, click Confirm and Stitch to begin stitching. You will 
be prompted to confirm and click Yes.

Stitching Job Options
After you click Yes to the Confirmation prompt, the Stitching Job Options window 
appears.
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Some options are not available for all tile sets.

Table 2    Stitching Job Options Overview (1 of 2)

Interface Item Description

Crop Image Crops the outer edges of the image to make it rectangular. Otherwise, it will 
potentially have jagged edges where the tiles have been shifted.

Blend Tiles Blends the overlapped regions of the tiles together to make it appear as one 
continuous image. In some rare cases, you may not want to blend the tiles.

Specify output image 
width

Determines the resolution of the stitched image.

Multichannel image(s) Currently enabled for Multichannel TIFF data only. 

Outputs each channel to a separate image file. See “Auto Selection” on page 86.

Flattened image Currently enabled for Multichannel TIFF data only. 

All channels are collapsed to a single image. 
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Auto Selection

For all image types, other than TIFF, the default stitching job option is auto selected.

 RAW and HDView: Multichannel auto selected. Outputs each channel to a separate 
image file.

 Multipage TIFF: Outputs each channel to a separate page of a single multi-page 
TIFF file.

Stitch to Project Stitches the tile set into an HD View image and displays it in the Viewer. The 
stitched output will appear as a new layer in the Layer control.

When selected, the field for Destination file name is not available.

Selecting Stitch to Project will not export the stitched output. The stitched image 
will only appear in the Maps project. For data export, use the Stitch to File feature.

Stitch to File Stitches the tile set into an HD View or single image and exports the file to the 
specified folder.

The output file is stored in the location and format specified: RAW, TIFF, OME.TIF 
(Multipage), or HDView, in the Destination File name field. The default is the 
current project’s data location, in HD View format.

Note: You must download HD View™ from the Microsoft web site to open the 
HDView.htm file to see the stitched image.

Destination File Name Specifies the path and file name for the stitched project.

OK Click OK to accept the default stitching job options and begin the stitching process.

Cancel Closes the window.

Table 2    Stitching Job Options Overview (2 of 2)

Interface Item Description
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4 SEM/SDB

Overview
This chapter describes user interface elements and procedures that are specific to the 
SEM/SDB (Small DualBeam) systems.

Topics include:

 User Interface Elements, below

 “Rotational Alignment” on page 105

 “Scan Rotation” on page 107

 “Stage Rotation” on page 107

 “Nav-Cam Alignment” on page 108

User Interface Elements
Topics include:

 “Microscope Menu” on page 88

 “Options Menu” on page 89

 “Tool Bar, Right Side” on page 93

 “Layer/Holder Definition Control” on page 94

 “Tile Set Tab” on page 95

 “Tile Set Right-Click Menu” on page 101

 “Nav-Cam Right-Click Menu” on page 102
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Microscope Menu
The Microscope menu only appears for SEM/SDB systems.

Table 1    Maps Microscope Menu Overview

Menu Selection Description

Take Snapshot Acquires a SEM image at the current stage position and HFW and 
places it on the Maps viewer as a snapshot. The HFW can be changed 
from the Tile right-click menu selection: “Snapshot Settings” on 
page 26. 

Import from 
NavCam 

Disabled only while under vacuum if the door mounted Nav-Cam is 
installed. See “Nav-Cam Prompt (SEM/SDB Only)” on page 68. 

Acquires and imports a Nav-Cam image, if the Nav-Cam is available. 
This top down image of the stage can be used for point and click 
navigation of the sample. See “Nav-Cam Alignment” on page 108.

Get Image from 
XTUI

Imports a SEM image currently displayed in the xT UI without re-
acquiring the image and places it on the Maps Viewer as a snapshot. 

Set Sample Tilt Before you enable it, confirm that the sample is perpendicular to the 
electron beam. This preliminary step adjusts the Maps stage to keep 
the sample at the same distance from the beam; thus, allowing 
navigation and tiling at stage tilt. Once you enable this menu option, it 
sets the current stage tilt to Sample Tilt.

NOTE: This makes the linked focus unavailable.

Restore Last 
Sample Tilt

After you make the Set Sample Tilt unavailable, this menu option 
appears. Click Restore Last Sample Tilt to restore the last sample tilt 
value.
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Options Menu
 For descriptions of common selections to all systems, see “Options” on page 22.

 For descriptions of SEM/SDB-specific selections, see the table below.

Unique selections for SEM/SDB
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Table 2     Options Menu, SEM/SDB Overview (1 of 3)

Menu Selection Description

Tile Set Templates: Displays a dialog that shows a collection of templates and their respective 
settings.

Microscope Settings: 

Critical tile 
acquisition time

Maps will display a warning whenever the acquisition parameters selected for a 
tile set, result in a per-tile acquisition duration larger than this threshold.
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Display critical 
acquisition time 
warning

Select this check box to enable Maps to present the critical time warning as a 
dialog window that must be dismissed before proceeding. If this option is 
disabled, then the warning will be displayed on the Layer Definition control, but it 
will not require acknowledgments.

Use Degauss when 
changing Working 
Distance

Enable the check box to automatically Degauss when changing working distance 
during queued acquisitions.

Stage settle delay [s] Allows setting a delay (in seconds) before acquisition to allow stage movement to 
settle. Without a delay, some image distortion can occur.

Stage alignment [°] If stage alignment is in use, the Clear button will be enabled to clear the 
alignment value.

Clear Alignment Clears the alignment value.

Nav-Cam: Door 
Mounted

Enable this check box if the system’s Nav-Cam is mounted to the exterior of the 
chamber door. Leave the check box disabled if there is a Nav-Cam inside the 
microscope's vacuum chamber.

When the Maps software is first started, you are prompted to indicate if the door-
mounted Nav-Cam is installed. Therefore, this option is only used to change the 
setting at a later date.

Nav-Cam: Clear 
Persisted Alignment

Clears the saved default Nav-Cam alignment that is applied to all acquired Nav-
Cam images. See“Nav-Cam Alignment” on page 108. 

To clear the Nav-Cam alignment for a single image, see “Clear Alignment” on 
page 91.

Snapshot Settings

(Disabled for SEM 
Offline)

Displays the Snapshot Settings window and the scan settings that will be used to 
acquire preview images and snapshots.

Table 2     Options Menu, SEM/SDB Overview (2 of 3)

Menu Selection Description
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Do Not Change Lens 
Mode

When this option is enabled, it will prevent the Maps application from switching 
the SEM into or out of UHR (immersion) mode. Setting this option to Disabled, 
allows a queued tile set to automatically activate UHR mode for image acquisition 
without manual user interaction in the xT UI. In most cases, you should leave this 
option set to its default value of Enabled.

Stitch Tile Sets When 
Done

(Disabled for SEM 
Offline)

Automatically adds a stitching job to the end of the job queue for each completed 
acquisition job. 

Turn Off Beam When 
Done

(Disabled for SEM 
Offline)

Turns off the beam after any queued acquisition and stitching jobs are completed.

Retract Detectors when 
Done

(Disabled for SEM 
Offline)

Retracts any insertable detectors after any queued acquisition and stitching jobs 
are completed.

Sleep When Done

(Disabled for SEM 
Offline)

Puts the system into Sleep mode after any queued acquisition and stitching jobs 
are completed.

Pump to HiVac When 
Done

Returns the microscope to HiVac mode after completing a LowVac acquisition.

Table 2     Options Menu, SEM/SDB Overview (3 of 3)

Menu Selection Description

W
A

R
N

IN
G

! The Do Not Change Lens Mode feature exists to block the ability of Maps to perform an action with a risk 
of hardware damage. The SEM should never be put into UHR mode while a magnetic sample is loaded in 
the chamber, since this could damage equipment inside the microscope. Only make this feature 
unavailable if you are certain the sample is non-magnetic and you are operating in a use case that 
requires Maps to change lens modes without user intervention.
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Tool Bar, Right Side
See “Left Side, All Systems” on page 30 for common selections to CorrSight and TEM.

Figure 1     Tool Bar, Right Side, SEM/SDB

Table 3    Tool Bar Descriptions, SEM/SDB

Tool Description

Electron Beam (SEM)

(Online version only)

Selects the Electron beam for imaging.

Ion Beam (FIB)

(Online version only)

Selects the Ion beam for imaging.

Import from Nav-Cam

(with Nav-Cam version only)

Disabled only while under vacuum if the door mounted Nav-Cam is 
installed. See “Nav-Cam Prompt (SEM/SDB Only)” on page 68. 

Acquires and imports a Nav-Cam image, if the Nav-Cam is available. This 
top down image of the stage can be used for point and click navigation of the 
sample. See “Nav-Cam Alignment (SEM/SDB and CorrSight Only)” on 
page 71.

Take Snapshot Acquires a SEM image at the current stage position and HFW and places it 
on the Maps viewer as a snapshot image. The HFW can be changed from the 
Tile right-click menu selection: “Snapshot Settings” on page 26. 

Electron 
Beam

Ion Beam

Import from 
Nav-Cam

Take 
Snapshot
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Layer/Holder Definition Control 
Displays controls/information for the selection in the Layer control: 

 Layer Group

Use the Opacity slider to set the measure of opaqueness (how much you can see 
through). The less opaque, the more transparent it becomes. Transparent images are 
useful when overlaying one image over another

 Holder
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Tile Set Tab

Topics in this section include:

 “Basic Tab” on page 96

 “Auto Functions Tab” on page 97

 “Advanced Tab” on page 99

Lock methodology: 
The three Tile controls are 
mathematically interlocked. 
Only one will be locked at a 
time. If you lock one of the 
controls and change another 
control, the third control 
changes to correspond with 
the other two control values.
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Basic Tab

Table 4     Tile Set Tab, Basic Tab Overview

Control Description

Name Displays the name of the current tile set.

Acquisition Type Specifies the beam to be used for imaging. Choices are: Electron or Ion.

Tiles X, Y Sets the number of tiles in the X and Y directions.

Tile HFW Specifies the horizontal field width (HFW) for each tile.

Total HFW Shows the total HFW for all of the tiles.

Resolution Specifies the image resolution. Choices will be specific to each system type.

Dwell Specifies the amount of time the beam dwells on each pixel when images are 
acquired.

Frames Sets the number of image frames.

Image Acquisition 
Time

Displays an estimated time required to acquire the tile set.

Number of Tiles 
Acquired

Displays the number of tiles and the total disk space required to acquire the current 
tile set. A message appears if there is not enough space on disk for the acquisition.

From Microscope Applies the current microscope setting.

To Microscope Applies these settings to the microscope.

Acquire Acquires this tile set.

Queue Adds this tile set to the job queue.

Specific selections for SEM/SDB
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Auto Functions Tab

Table 5    Tile Set Tab, Auto Functions Tab Overview (1 of 2)

Control Description

Focus Strategy Specifies the focus setting. Choices are:

• None: The application will not touch the focus at all. You are free to change the 
focus via the xT UI during the run.

• Autofocus: Runs the autofocus routine at each tile before acquisition. This can 
result in better focus per tile, but adds considerably more time to acquisition. 

• Fixed: Uses the same working distance for every tile.

• Interpolated: User will select three focus points on the sample and a focus 
plane will be defined by these points. Each tile’s focus will be set based on 
where it is located in this plane.



SEM/SDB ■ User Interface Elements

P N  1 1 4 8 9 1 3 - A  ■ 1 1 / 0 3 / 1 7 98

Maps 3.3 User GuideFEI CONFIDENTIAL, Limited Rights Data

Focus Strategy (cont.) Procedure: Navigate to the first location. Manually focus the image. When 
image is in focus, click Set Focus 1 button. The current working distance will 
be remembered for that point and the button will now be checked. Repeat for 
the other two Set Focus buttons. Once all three are checked, tiles are ready to 
be acquired.

Note: These points will then be used to define a focus plane, so that all tiles 
will use a WD as defined by this plane. Choosing points that are at opposite 
ends of the sample is important to get the best results.

To unset a focus point, click Set Focus for that point. Set Focus is an on/off 
toggle.

• InitialAutoFocus or SingleAutoFocus: Performs a single autofocus routine at 
the center of the tile set and uses the resulting focus for the entire tile set. 

Stigmation Specifies the stigmation options:

• AutoStig: Runs the auto stig routine for every tile in the tile set.

• Fixed: Allows saving of the current stig from the microscope and sets this 
value whenever this tile set is run.

• Initial AutoStig: Runs the auto stig routine before running the tile set.

• None: No auto stig routine will be run.

Table 5    Tile Set Tab, Auto Functions Tab Overview (2 of 2)

Control Description
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Advanced Tab

Use the controls on this tab to set advanced tile acquisition properties for each tile set.

Table 6    Tile Set Tab, Advanced Tab Overview (1 of 2)

Control Description

Quads(1-4) Select multiple quads to acquire images from multiple display channels.

Detector Selects the method for acquiring detector settings. You can set up different tile sets 
with different detectors and line them up for acquisition. When selected, a label 
displays the current setting.

Stitching Quad Selects the quad to be used for stitching reference. It is best to choose the quad that 
will have the most image data.

Beam Current Selects the method for acquiring the total amount of electron or ion current striking 
the sample. When selected, a label displays the current setting.

Check box methodology:
 When the check boxes 

are not selected, the 
software uses the values 
set in the xT user 
interface when the tile 
set acquisition began.

 When the check boxes 
are selected, the 
software locks in the 
current xT user interface 
setting. This allows you 
to set specific values for 
different tile sets.
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High Voltage Selects the method for acquiring the high voltage setting. When selected, a label 
displays the current setting.

Lens Mode Selects the electron beam lens mode which sets the value of either standard or 
immersion mode. 

16-bit image When selected, saves image as 16-bit (65K grayscale levels), else image is saved as 
8-bit (256 grayscale levels).

Order Determines the order in which the contained tiles will be acquired. Options are:

• Raster: Left to right, then top to bottom.

• Serpentine: Alternating left to right pattern per row, running top to bottom.

• Spiral: Iterating over tiles in a clockwise pattern starting with the outer most 
tiles moving inward.

Line Integration Specifies the number of times each raster line is scanned and integrated to combat 
certain types of drift.

Scan Interlacing Specifies the number of times each frame is interlaced to combat certain types of 
drift.

Overlap X, Y Displays the percentage of overlap between tiles in the tile set, as well as the pixels.

Pixel Size Specifies the physical size of a single pixel at the current acquisition settings. This 
is based on Tile HFW and Resolution (from Basic settings tab).

Stage X Sets the X stage location of the center of the tile grid.

Stage Y Sets the Y stage location of the center of the tile grid.

Stage R Sets the stage rotation at which the tiles will be acquired. Existing tile sets rotate 
with the stage. New tile grids are created at the current rotation. Select the check 
box to enable the text field to change the default rotation.

Scan Rotation Allows manual adjustment of scan rotation for a tile set. Either enter a value in the 
edit box here or rotate the tile set in the viewer to update the scan rotation value.

Stage T Sets the stage tilt at which the tiles will be acquired. Select the check box to enable 
the text field to change the default tilt.

Stage Z Sets the stage height (Z) to be stored and used for acquisition. This allows multiple 
tile sets to be acquired at different heights, that is sometimes necessary for using 
different detectors. If left unselected, the stage height will not be changed.

Auto Contrast & 
Brightness

Enables the Auto Contrast & Brightness routine to be run.

Table 6    Tile Set Tab, Advanced Tab Overview (2 of 2)

Control Description
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Tile Set Right-Click Menu
Right-click on any tile set to access a context menu.

 For descriptions of common selections to all systems, see “Tile Set Right-Click Menu” 
on page 46.

 For descriptions of SEM/SDB-specific selections, see the table below.

Table 7    Tile Set Right-Click Menu Overview

Menu Selection Description

Square Up Rotates the stage to match the orientation of the tile set.

Use for Stage 
Alignment

When selected, uses the offsets calculated in the acquired tile set to correct for 
misalignment between the scan axes and the stage axes by applying a small scan 
rotation. This will allow better acquisition and alignment of future tile sets.

Unique selections for SEM/SDB



SEM/SDB ■ User Interface Elements

P N  1 1 4 8 9 1 3 - A  ■ 1 1 / 0 3 / 1 7 102

Maps 3.3 User GuideFEI CONFIDENTIAL, Limited Rights Data

Nav-Cam Right-Click Menu
The Nav-Cam image is stored in the selected layer. Right-click on a Nav-Cam entry to 
access a context menu. 

 For descriptions of common selections to all systems, see “Annotation Right-Click 
Menu” on page 43.

 For descriptions of SEM/SDB-specific selections, see the table below.

Table 8    Nav-Cam Right-Click Menu Overview

Menu Selection Description

Persist Nav-Cam 
Alignment

Keeps the current Nav-Cam alignment.

Unique selection for Nav-Cam.
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Viewer Tile Right-Click Menu
Right-click on a tile within the tile grid to access a context menu.

 For common selections, see “Viewer Tile Right-Click Menu” on page 56.

 For SEM/SDB-specific selections, see the table below.

Specific selections for SEM/SDB
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Table 9    Viewer Tile Right-Click Menu, SEM/SDB Overview

Menu Selection Description

Rotational Alignment Allows rotation of the stage to Place Point 1, Place Point 2, or Cancel. See 
““Rotational Alignment” on page 105.

Snapshot Here with HFW Acquires a preview SEM image at the selected stage coordinate and current 
HFW. Submenu choices:

This is the same functionality as using the Take Snapshot Image tool box 
button. See “Take Snapshot” on page 93. 

Preview Tile(s) Displays the image for that tile. Any tiles without pertinent image data can be 
disabled from image acquisition.

Sub-tile Displays a submenu for selecting the number of sub-tiles to be in a mini grid 
within an individual tile, using the selected number of images. 

The sub-tile names are automatically added to the Layers control 
(TileSet: (3,4)).
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Rotational Alignment

1. Right-click where point 1 is to be placed, then click Rotational Alignment, then 
Place Point 1.

C
A

U
T

IO
N

Take care when using this feature with detectors inserted. Also, verify the clearance of 
installed stage hardware manually using the xT UI before performing the rotation in Maps.
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2. Right-click where point 2 is to be placed, then click Rotation Alignment, then Place 
Point 2. A message appears asking which rotation you want to use.

 Stage Rotation: Uses stage rotation to align the image.

 Scan Rotation: Uses scan rotation to adjust the image.
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The stage rotates to make the line between Points 1 and 2 horizontal in the viewer.

Scan Rotation
Scan rotation rotates the scan and aligns the image. It has no effect on the stage 
movements and is solely a scan coil function, but is used to orient the image relative to 
mechanical rotation and detector direction.

A non-zero scan rotation is indicated by an icon in the Status bar for the electron and ion 
beam independently, and its value can be shown as a tool tip. Click ^ to assign the viewer 
rotation to the value in the text box next to it. 

Stage Rotation
Type a value into the text box and press Enter to rotate the stage.
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Nav-Cam Alignment
For systems that have the Nav-Cam, Maps is able to acquire Nav-Cam images and align 
them. Maps is also able to save the Nav-Cam Alignment to be automatically applied to all 
future Nav-Cam images acquired with Maps.

Procedure for Nav-Cam Alignment:

1. Click the Import from Nav-Cam tool bar icon.

2. When the Nav-Cam image appears in Maps, right-click on its name in the Layer 
control and then click Align in the menu that appears.
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3. Follow the alignment wizard to perform the coarse point alignment (1-, 2- or 3-
Point) as described in “1-, 2-, or 3-Point (Coarse) Alignment” on page 196. 

4. Follow the alignment wizard to perform fine alignment adjustments as described in 
“Fine Alignment” on page 200. 
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5. Test the Nav-Cam alignment by navigating to features on the sample and acquiring 
preview images. If the Nav-Cam image is not sufficiently aligned, perform the 
alignment procedure again. 

6. When the Nav-Cam image is sufficiently aligned, right-click on its name in the 
Layer control and select Persist Nav-Cam Alignment in the menu that appears. 

All subsequent Nav-Cam acquisitions using Maps will use this alignment.

7. To clear the Nav-Cam alignment for an individual Nav-Cam image, right-click the 
Nav-Cam image in the Layer control and select Alignment > Clear Alignment. 
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8. To clear the saved default Nav-Cam alignment that is applied to all acquired Nav-
Cam images, select Options > Microscope Settings > Clear Persisted Alignment. 
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5 CorrSight

Overview
This chapter describes user interface elements and procedures that are specific to the 
CorrSight systems.

For procedural information on the light microscope operation itself, refer to the 
documentation that came with your system.

Topics include:

 User Interface Elements, below

 “Microscope Controls” on page 123

 “Live Imaging” on page 126

 “Live Imaging Controls” on page 127

 “Nav-Cam Support” on page 129

 “Nav-Cam Alignment” on page 129

User Interface Elements
Topics include:

 “Options Menu” on page 113

 “Tool Bar, Right Side” on page 114

 “Layer/Holder Definition Control” on page 115

 “Tile Set Tab” on page 116

 “Preview Layer, Nav-Cam Right-Click Menu” on page 121

 “Viewer Tile Right-Click Menu” on page 122
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Options Menu
 For descriptions of common selections to all systems, see “Options” on page 22.

 For descriptions of SEM/SDB-specific selections, see the table below.

Table 1     Options Menu Overview

Menu Selection Description

Tile Set Templates: Displays a dialog that shows a collection of templates and their respective 
settings.

Stitch Tile Sets When 
Done

(Disabled for CorrSight 
Offline)

Automatically adds a stitching job to the end of the job queue for each completed 
acquisition job. 

Specific selection for CorrSight
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Tool Bar, Right Side
See “Left Side, All Systems” on page 30 for common selections to SEM/SDB and TEM.

Figure 1     Tool Bar, Right Side

Table 2    Tool Bar Descriptions

Tool Description

Import from Nav-Cam

(with Nav-Cam version only)

This is unavailable while under vacuum if the door mounted Nav-Cam is 
installed. See “Nav-Cam Prompt (SEM/SDB Only)” on page 68. 

Acquires and imports a Nav-Cam image, if the Nav-Cam is available. This 
top down image of the stage can be used for point and click navigation of the 
sample. See “Nav-Cam Alignment” on page 129.

Take Snapshot Acquires an image at the current stage position and HFW and places it on the 
Maps viewer as a snapshot image. The HFW can be changed from the Tile 
right-click menu selection: “Snapshot Here” on page 57. 

Live Imaging Toggles live imaging on and off. See “Live Imaging” on page 126.

Start FlowControl Starts the FlowControl software used to control the pump and valves of the 
CorrSight live module. It allows manual and automated control of the live 
module by protocols defined and executed by FlowControl. The calibration 
of the flow rate can also be done with FlowControl.

Import from 
Nav-Cam

Take 
Snapshot

Live 
Imaging

Start 
FlowControl
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Layer/Holder Definition Control 
Displays controls/information for the selection in the Layer control: 

 Layer Group

Use the Opacity slider to set the measure of opaqueness (how much you can see 
through). The less opaque, the more transparent it becomes. Transparent images are 
useful when overlaying one image over another

 Holder
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Tile Set Tab

Topics in this section include:

 “Basic Group” on page 117

 “Z-Stack Setup Group” on page 119

 “Focus Group” on page 120
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Basic Group

Table 3    Tile Set Tab, Basic Group Overview (1 of 2)

Control Description

Name Displays the name of the current tile set.

Acquisition Mode Specifies the Acquisition mode (hardware specific): 

• Widefield

• Structured Illumination

• Spinning Disk

Note: Some acquisition modes are not available on all systems.

Tiles X, Y Sets the number of tiles in the X and Y directions.

Objective Displays the objective lens selections: 4X, 10X, and 40X, and the immersion type: 
Air, Oil, Glycerol, Water, or Special installed on your microscope.

The display is configured in the Live Acquisition software.

The depressed blue indicator button is the selected objective lens.

Note: Take care when changing between objective lenses with different immersion 
types.

HFW Specifies the horizontal field width (HFW) for each tile.

Total HFW Shows the total HFW for all of the tiles.

Resolution Specifies the image resolution. Choices will be specific to each system type.

Specific selections for CorrSight
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Time Series Loops Specifies the number of times to acquire a tile set at a specified time interval to 
collect images of a sample that is changing with time.

Time Series Interval Specifies the time interval for the specified number of times to acquire a tile set to 
collect images of a sample that is changing with time.

Shading Correction Uses a blank reference image to correct (remove) shading effects in all images 
acquired inside the tile set. 

Note: When the shading Correction feature is enabled on a tile set, the corrected 
(post-processed) images are saved with the Maps project and the original (pre-
processed images) are discarded. If your use case requires preserving the 
information in the original (uncorrected) image for later analysis, then make sure 
that shading correction is disabled for your critical tile set. 

Note: Before this feature can be used in the Maps application, the reference must be 
acquired and stored using the Live Acquisition application.

Stretch Histogram Automatically adjusts the min/max pixel intensities as images are acquired.

Stitching Channel The channel names and colors are configured in the Live Acquisition software.

At least one channel must be selected. The Exposure Time (ms) and Intensity (%) 
display for each selected channel.

• Exposure Time: The time (in milliseconds) that the sample is illuminated for 
imaging.

• Intensity: The percentage of maximum (full) illumination.

As soon as you create a tile set, all enabled channels are applied when the tile set is 
acquired.

From Microscope Applies the current microscope settings to this tile set.

To Microscope Applies these settings to the microscope.

Table 3    Tile Set Tab, Basic Group Overview (2 of 2)

Control Description
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Z-Stack Setup Group

A Z-stack is a series of multiple images taken with varying focus. Each tile in a grid is a 
separate stack for a Z-stack acquisition.

Table 4    Tile Set Tab, Z-Stack Setup Overview

Control Description

Stack Mode Defines the Z-stack as:

• None: No Z-stack defined

• Relative: To the defined midpoint of the stack

• Absolute: To the top and bottom of the stack
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Focus Group

Table 5    Tile Set Tab, Focus Group Overview

Control Description

Focus Strategy Specifies the focus setting. Choices are:

• None: The application will not touch the focus at all. You are free to change the 
focus via the xT UI during the run.

• Autofocus: Runs the autofocus routine at each tile before acquisition. This can 
result in better focus per tile, but adds considerably more time to acquisition. 

• Fixed: Uses the same working distance for every tile.

• Interpolated: User will select three focus points on the sample and a focus 
plane will be defined by these points. Each tile’s focus will be set based on 
where it is located in this plane.

Procedure: Navigate to the first location. Manually focus the image. When 
image is in focus, click Set Focus 1 button. The current working distance will 
be remembered for that point and the button will now be checked. Repeat for 
the other two Set Focus buttons. Once all three are checked, tiles are ready to 
be acquired.

Note: These points will then be used to define a focus plane, so that all tiles 
will use a WD as defined by this plane. Choosing points that are at opposite 
ends of the sample is important to get the best results.

To unset a focus point, click Set Focus for that point. Set Focus is an on/off 
toggle.

Focus Strategy (cont.) • InitialAutoFocus or SingleAutoFocus: Performs a single autofocus routine at 
the center of the tile set and uses the resulting focus for the entire tile set. 
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Preview Layer, Nav-Cam Right-Click Menu
The Nav-Cam image is stored in the selected layer. Right-click on a Nav-Cam entry to 
access a context menu. 

 For descriptions of common selections to all systems, see “Annotation Right-Click 
Menu” on page 43.

 For descriptions of CorrSight-specific selections, see the table below.

Table 6    Preview Layer, Nav-Cam Right-Click Menu Overview

Menu Selection Description

Persist Nav-Cam 
Alignment

Keeps the current Nav-Cam alignment.

Unique selection for Nav-Cam.
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Viewer Tile Right-Click Menu
Right-click on a tile within the tile grid to access a context menu.

Figure 2     Viewer Tile Right-Click Menu, All Systems

SEM/SDB TEM CorrSight
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Microscope Controls

Figure 3     Microscope Controls

See “Channels:” on 
page 124

See “Focus:” on page 125

See “Acquisition 
Mode” on page 124

See “Objective Lens 
Selection” on page 124

Collapse Controls

See “Info Board” on 
page 125
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Table 7    Microscope Controls Overview (1 of 2)

Interface Item Description

Objective Lens 
Selection

Displays the objective lens selections: 4X, 10X, and 40X, and the immersion type: 
Air, Oil, Glycerol, Water, or Special installed on your microscope.

The display is configured in the Live Acquisition software.

The outlined button is the selected objective lens.

Note: Take care when changing between objective lenses with different immersion 
types.

Channels:

Acquisition Mode

Specifies the Acquisition mode (hardware specific): 

• Widefield

• Structured Illumination

• Spinning Disk

Note: Some acquisition modes are not available on all systems.

Channel Selection The channel names and colors are configured in the Live Acquisition software. The 
active channel is highlighted when live imaging.

At least one channel must be selected. As soon as you create a tile set, all enabled 
channels are applied when the tile set is acquired.

Exposure Time Time the camera sensor is exposed to the light source.

Intensity Intensity of the light source.

Contrast Method Transmitted light contrast is a software supported method to improve the contrast of 
transmission images for CorrSight instruments.
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Focus:

Focus Specifies the current focus position.

Step Size Specifies the step size of the auto focus.

Auto Focus Uses the step size for live imaging Auto Focus.

Info Board For microscopes with the a Cryogenic cooling system.

Table 7    Microscope Controls Overview (2 of 2)

Interface Item Description
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Live Imaging
Click the Live Imaging icon in the tool bar to start live imaging.

Live Image Window

Double-click on a feature to center that point on the stage and within the Live Image 
window.

Use the mouse scroll wheel or right-click and drag to change focus. 
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Live Imaging Controls

Figure 4     Live Imaging Controls

See “Histogram” 
on page 128

See “Semi-log” 
on page 128

See “Auto” 
on page 128

See “Saturation” 
on page 128

See “Mini Viewer” 
on page 128

See “Microscope 
Controls” on 
page 123
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Table 8    Live Imaging Controls Overview (1 of 2)

Interface Item Description

Auto When selected, continuously adjusts the min and max for the histogram display.

Semi-log When selected, changes the histogram intensity display to logarithmic.

Histogram

• Any data above the max line is white.

• Any data below the min line is black.

• In between max and min are the graylevels.

Saturation When selected, the saturated pixels are colored red. 

Mini Viewer The Mini Viewer has all of the functionality of the main viewer.

Gamma Control 
Slider

Adjusts the gamma for the live image.

Max Min

Histogram Data

(graphic is shown rotated 
90 degrees to the left)

Current Max Position Current Min Position

Gamma control slider



CorrSight ■ Nav-Cam Support

P N  1 1 4 8 9 1 3 - A  ■ 1 1 / 0 3 / 1 7 129

Maps 3.3 User GuideFEI CONFIDENTIAL, Limited Rights Data

Nav-Cam Support
Maps supports the use of importing a Nav-Cam image while on a CorrSight via the same 
tool bar button found when running Maps on xT. 

See Tool Bar “Tool Bar, Right Side” on page 114.

Nav-Cam Alignment
For systems that have the Nav-Cam, Maps is able to acquire Nav-Cam images and align 
them. Maps is also able to save the Nav-Cam Alignment to be automatically applied to all 
future Nav-Cam images acquired with Maps.

Procedure for Nav-Cam Alignment:

1. Click the Import from Nav-Cam tool bar icon.

Reset Returns to the default gamma setting.

Table 8    Live Imaging Controls Overview (2 of 2)

Interface Item Description
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2. When the Nav-Cam image appears in Maps, right-click on its name in the Layer 
control and click Align in the menu that appears.
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3. Perform a 2 or 3 point alignment as described in “1-, 2-, or 3-Point (Coarse) 
Alignment” on page 196. 
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4. Perform fine alignment adjustments, if needed, as described in “Fine Alignment” on 
page 200. 
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5. Test the Nav-Cam alignment by navigating to features on the sample and acquiring 
preview images. If the Nav-Cam image is not sufficiently aligned, perform the 
alignment procedure again. 

6. When the Nav-Cam image is sufficiently aligned, right-click on its name in the 
Layer control and select Persist Nav-Cam Alignment in the menu that appears. 

All subsequent Nav-Cam acquisitions using Maps will use this alignment.

7. To clear the Nav-Cam alignment for an individual Nav-Cam image, right-click the 
Nav-Cam image in the Layer control and select Alignment > Clear Alignment. 
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8. To clear the saved default Nav-Cam alignment that is applied to all acquired Nav-
Cam images, select Options > Microscope Settings > Clear Persisted Alignment. 
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6 TEM

Overview
This chapter describes user interface elements and procedures that are specific to the TEM 
and STEM modes on TEM systems.

User Interface Elements
Topics include:

 Options Menu, below

 “Tool Bar, Right Side” on page 139

 “Tile Set Tab, TEM Mode” on page 140

 “Tile Set Tab, STEM Mode” on page 144

 “Viewer Tile Right-Click Menu” on page 148

 “Magnification Alignment” on page 149

Options Menu
 For descriptions of common selections to all systems, see “Options” on page 22.

 For descriptions of TEM-specific selections, see the table below.

Specific selections for TEM
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Table 1    Options Menu Overview (1 of 3)

Menu Selection Description

Tile Set Templates: Displays a dialog that shows a collection of Tile Set templates and their respective 
settings. These templates contain user-defined presets for commonly used 
acquisition settings. The TEM mode has a default template and a standard 
template. Note that TEM and STEM templates differ slightly with their exact 
properties. 

Default Template: This template contains a subset of acquisition settings, filling 
the rest of the acquisition settings from the current settings on the microscope 
when the Tile Set is created. This facilitates the more interactive mode when the 
instrument UI is used for defining optical settings. 

Standard Template: This template is editable, so you can utilize more settings 
than the default template 

Default Template

Standard Template
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Alignment Corrections Displays the corrections that currently apply for metrology analysis.

Microscope Settings 

• Use Backlash correction for Stage check box: When enabled (default), 
stage moves are more accurate as the moves will be performed in a way to 
reduce backlash and wind-up effects. Usually there is no need to turn this 
correction off and this switch is mostly used for diagnostics. One might 
consider to temporarily turn the correction off to speed up low-magnification 
overviews (at the cost of accuracy) as the corrected move takes a bit longer.

• STEM Scan Orientation Correction: This is a small correction angle for 
compensating imperfections in the calibration of the STEM scan rotation. 
The default value for this setting is 0. Only adjust this value if there is a 
significant systematic misalignment between tiles in STEM mode.

• Stage Axis Angle Correction: This is a small correction angle that allows for 
compensating for mechanical imperfections, if present, in the orthogonality 
between the X and Y axis of the stage. The default value for this setting is 0. 
Only adjust this value if there is a recurring, significant misalignment 
between tiles in TEM and STEM modes. Contact your application engineer 
for a measurement procedure or consult an application note.

• Beam Blanker Unblank Setting Time: After blanking or unblanking the 
beam, it takes a short time for the optics to settle. The default values are 
sufficient for most systems, but on Tecnai systems without a fast beam 
blanker, a value of 1–3 seconds is recommended. An insufficient setting time 
manifests itself only in STEM mode, resulting in tile images where the top 
part starts out black and unstable.

Table 1    Options Menu Overview (2 of 3)

Menu Selection Description
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Snapshot Settings TEM Mode: Selects the Exposure Time that will be used for the acquisition of 
snapshot images. Snapshots will always be acquired with the maximum camera 
resolution, such as, binning 1.

STEM Mode: Displays the Detector, Dwell Time, and Resolution Settings that 
will be used for acquisitions of snapshot images when in STEM mode.

Close Column Valves 
When Done

Closes the column valves after any queued acquisition and stitching jobs are 
completed.

Switch off Emission 
when Done

Applies only to systems with thermionic guns (such as, Talos LaB6). When 
enabled, turns of the gun emission after queued acquisition to preserve the 
filament. Note that re-enabling emission must be performed outside MAPS via the 
TEM User Interface.

Table 1    Options Menu Overview (3 of 3)

Menu Selection Description

TEM view

STEM view
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Tool Bar, Right Side
See “Left Side, All Systems” on page 30 for common selections to CorrSight and 
SEM/SDB.

Figure 1     Tool Bar, Right Side, TEM

Table 2    Tool Bar Descriptions, TEM

Tool Description

Take Snapshot Acquires a TEM image at the current stage position and magnification and 
places it on the Maps viewer as a snapshot image.

See “Snapshot Settings” on page 138

Magnification Alignment Aligns tile sets from one magnification to another to correct small shifts. See 
“Magnification Alignment” on page 149.

Take Snapsot

Magnification Alignment
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Tile Set Tab, TEM Mode
Topics in this section include:

 Basic Group, TEM Mode, below

 “Advanced Group, TEM Mode” on page 142

Basic Group, TEM Mode

Table 3    Tile Set Tab, TEM Mode, Basic Group Overview (1 of 2)

Control Description

Name Displays the name of the current tile set.

Tile Set Type Indicates that the acquisition mode for this tile set is TEM or STEM.

Camera Selects the camera that will be used for the acquisition of tile images. Unsupported 
cameras are also listed and indicated in the camera dropdown list. These 
unsupported cameras may work with Maps, but compatibility is not guaranteed.

Tiles X, Y Sets the number of tiles in the X and Y directions.

Overlap X, Y Displays the percentage of overlap between tiles in the tile set as well as the pixels.

Tile HFW For TEM, this is not editable. It is determined by the magnification, camera, and 
other optical settings.

Total Area Displays the total HFW for all of the tiles.

Specific selections for TEM mode
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Resolution Specifies the image resolution. Choices will be specific to each system type.

Magnification Selects the magnification that will be used for the acquisition of the tile images

Pixel Size Displays the physical size of a single pixel at the current acquisition settings. This is 
based on Tile HFW and Resolution.

Exposure Time Specifies the exposure time on the camera for each tile acquisition.

Number of Tiles 
Acquired

Displays the number of tiles and the total disk space required to acquire the current 
tile set. A message appears if there is not enough space on disk for the acquisition.

From Microscope Reads the current optical settings from the microscope and stores them in the 
acquisition settings of the selected tile set.

To Microscope Sets the optical parameters of the acquisition settings of the selected tile set to the 
microscope.

Table 3    Tile Set Tab, TEM Mode, Basic Group Overview (2 of 2)

Control Description

N
O

T
E

From Microscope/To Microscope controls:
 Camera settings are not read from or written to the microscope; camera settings only 

apply during acquisition.
 Not all the optical acquisition settings can be edited directly. Some optical acquisition 

settings require clicking From Microscope to update the values.
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Advanced Group, TEM Mode

The advanced parameters are initially set at the creation of the tile set and filled with the 
settings of the selected template or with the current settings on the system if the default 
template is used. After creation of the tile set, click From Microscope to update the 
settings to the current state on the instrument. Some settings can also be typed in directly.

Table 4    Tile Set Tab, TEM Mode, Advanced Group Overview (1 of 2)

Control Description

Noise Reduction Specifies the Noise Reduction setting associated with the BM-Ceta camera. See the 
Ceta 16M Application Instructions for details.

Frames Summed Specifies the Frames Summed setting associated with the BM-Ceta camera. See the 
Ceta 16M Application Instructions for details.

Illuminated Area Specifies the beam intensity that will be used during the tile set acquisition.

Spot Size Specifies the spot size that will be used during the tile set acquisition.

Probe Mode Specifies the probe mode such as the NanoProbe or MicroProbe that will be used 
during the tile set acquisition.

These camera settings are specific to the 
selected camera. The BM-Ceta camera is 
shown in this example and it has two 
settings: Noise Reduction and Frames 
Summed.
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Focus Method Specifies if the tile set should be acquired with specific focus settings or none at all. 
There the following two options: 

• None: The focus on the microscope will be left as is.

• Fixed: The tile set will be acquired at a fixed focus value to be stored in the tile 
set with the From Microscope button plus an optional relative Defocus for 
contrast formation.

Defocus When Focus Method is set to Fixed, specifies the amount of relative defocus that 
will be applied when acquiring the tiles. 

Note: Sets the focus to the microscope, not the defocus. The defocus is only applied 
during acquisition as a relative value on top of the Focus setting that was stored 
with the tile set.

Focus When the Focus Method is set to Fixed, this is the lens focus setting that will be 
applied when acquiring the tile set. To update this value, click From Microscope.

Stage Z When Focus Method is set to Fixed, specifies the Z coordinate at which the tile set 
will be acquired. 

Click the check box to retrieve the current value from the instrument.

Use image corrections When this setting is enabled, a small image correction is applied to the acquired tile 
images resulting in improved tile set accuracy. Using this setting slightly affects the 
raw data recorded by Maps. If this result is undesired, turn off the image correction. 
This results is less accurate navigation.

Note: When the correction is enabled, the tiles are slightly smaller. Also, with the 
correction enabled you can notice a small difference between the purple field-of-
view rectangle and outline of the tiles.

From Microscope Reads the current optical settings from the microscope and stores them in the 
acquisition settings of the selected tile set.

To Microscope Sets the optical parameters of the acquisition settings of the selected tile set to the 
microscope.

Table 4    Tile Set Tab, TEM Mode, Advanced Group Overview (2 of 2)

Control Description
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Tile Set Tab, STEM Mode
Topics in this section include:

 Basic Group, STEM Mode, below

 “Advanced Group, STEM Mode” on page 146

Basic Group, STEM Mode

Table 5    Tile Set Tab, STEM Mode, Basic Group Overview (1 of 2)

Control Description

Name Displays the name of the current tile set.

Tile Set Type Displays the microscope mode for the tile set, which is either TEM (“Tile Set Tab, 
TEM Mode” on page 140) or STEM

Tiles X, Y Sets the number of tiles in the X and Y directions.

Overlap X, Y Displays the percentage of overlap between tiles in the tile set as well as the pixels.

Specific selections for STEM mode
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Tile HFW For STEM, this is not editable. It is determined by the magnification, camera, and 
other optical settings.

Total Area Displays the total HFW for all of the tiles.

Mode Selects the probe mode of the beam: Microprobe, Nanoprobe, or LM. Note that in 
order to use LM STEM, it is strongly recommended to first enable LM STEM via 
the TEM User Interface.

Scan Field Of View Defines the size of the scan area and magnification for the acquisition of each tile.

Resolution Specifies the image resolution. Choices will be specific to each system type.

Pixel Size Displays the physical size of a single pixel at the current acquisition settings. This is 
based on Tile HFW and Resolution.

Dwell Time Specifies the amount of time the beam dwells on each pixel when images are 
acquired.

Scan Rotation Defines the orientation of the scanning, which determines the orientation of the 
image. The tile set orientation is adjusted accordingly. Typical use of this property 
is to line up the acquired images to a feature on the sample.

Detector Selects the detector that will be used for the acquisition of tile images.

Frame Time The estimated time each tile acquisition will take.

Number of Tiles 
Acquired

Displays the number of tiles and the total disk space required to acquire the current 
tile set. A message appears if there is not enough space on disk for the acquisition.

From Microscope Reads the current optical settings from the microscope and stores them in the 
acquisition settings of the selected tile set.

To Microscope Sets the optical parameters of the acquisition settings of the selected tile set to the 
microscope.

Table 5    Tile Set Tab, STEM Mode, Basic Group Overview (2 of 2)

Control Description

N
O

T
E

From Microscope/To Microscope controls:
 Camera settings are not read from or written to the microscope; camera settings only 

apply during acquisition.
 Not all the optical acquisition settings can be edited directly. Some optical acquisition 

settings require clicking From Microscope to update the values.
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Advanced Group, STEM Mode

Use the controls on this group to set advanced tile acquisition properties for each STEM 
tile set. The advanced parameters are initially set at the creation of the tile set and filled 
with the settings of the selected template or with the current settings on the instrument if 
the default template is used. After creation of the tile set, click From Microscope to update 
the settings to the current state on the microscope. Some settings can also be entered 
directly.

Table 6    Tile Set Tab, STEM Mode, Advanced Group Overview (1 of 2)

Control Description

Spot Size Specifies the spot size that will be used during the tile set acquisition. 

Camera Length Specifies the STEM camera length, which is typically used to tune the contrast of 
the images.

Beam Convergence 
Angle

Specifies the convergence of the beam used during STEM acquisition.
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Beam Convergence 
Angle Range

The convergence range specifies whether or not large angles are allowed for the 
convergence angle. Note that large angular range implies an additional cross over.

Contrast Specifies the contrast setting of the detector, which represents the dynamic range of 
the detected signal (that is, it defines the amplification of the detector signal).

Brightness Specifies the brightness setting of the detector, which represents the null level of the 
detected signal (that is, it defines the offset of the detector signal). 

Focus Method Specifies if the tile set should be acquired with specific focus settings or none at all. 
There the following two options: 

• None: The focus on the microscope will be left as is.

• Fixed: The tile set will be acquired at a fixed focus value to be stored in the tile 
set with the From Microscope button.

Intensity Focus When the Focus Method is set to Fixed, specifies the beam intensity at which the 
tile set will be acquired. This lens focus setting will be set during tile set 
acquisition. To update this value, click From Microscope.

Objective Focus When the Focus Method is set to Fixed, specifies the objective focus at which the 
tile set will be acquired. This lens focus setting will be set during tile set 
acquisition. To update this value, click From Microscope.

Stage Z When Focused Method is set to Fixed, specifies the z coordinate at which the tile 
set will be acquired.

Use image corrections When this setting is enabled, a small image correction is applied to the acquired tile 
images resulting in improved tile set accuracy. Using this setting slightly affects the 
raw data recorded by Maps. If this result is undesired, turn off the image correction 
(that is, at cost of slightly less accurate navigation).

Note: When the correction is enabled, the tiles are slightly smaller. Also, with the 
correction enabled you can notice a small difference between the purple field-of-
view rectangle and outline of the tiles.

From Microscope Reads the current optical settings from the microscope and stores them in the 
acquisition settings of the selected tile set.

To Microscope Sets the optical parameters of the acquisition settings of the selected tile set to the 
microscope.

Table 6    Tile Set Tab, STEM Mode, Advanced Group Overview (2 of 2)

Control Description
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Viewer Tile Right-Click Menu
Right-click on a tile within the tile grid to access a context menu.

 For common selections, see “Viewer Tile Right-Click Menu” on page 56.

 For TEM-specific selections, see the table below.

Table 7    Viewer Tile Right-Click Menu Overview

Menu Selection Description

Take Snapshot Takes a single snapshot at the current microscope location.

Rotate Viewer to FOV Digitally rotates the viewer to line up the display to the orientation of the 
current field-of-view (as indicated by the purple rectangle).

Rotate Viewer to 
Tile Set

Digitally rotates the viewer so the current tile set is aligned with the screen. 
See Figure 20, “Viewer Tile Right-Click Menu Overview,” on page 57.

Specific selections for TEM
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Magnification Alignment

Introduction
On TEM systems, you will observe imperfections in the tile set alignment from one 
magnification to another. These imperfections result in small shifts when changing the 
magnifications. You must always properly calibrate and align the system, but small shifts 
may still remain since changes in the optics can lead to additional shift. To compensate for 
the small shifts that may remain, you can use the drag-and-drop functionality of Maps to 
align tile sets.

Magnification Alignment versus Manual Alignment
There are two alignment mechanisms available in Maps: Magnification Alignment and 
manual alignment. The Magnification Alignment moves the data in the Maps canvas and 
stores this alignment for subsequent acquisitions (at the same magnification). The manual 
alignment described in “Manual Alignment” on page 195 only aligns the data within the 
Maps canvas. Any subsequent acquisition will not have access to information about the 
alignment.

Aligning a Tile Set and Its Magnification
1. Click the acquired tile set that is slightly misaligned. For example, the higher 

magnification tile set within the green border is misaligned with respect to the lower 
magnification.
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2. Right-click on the selected tile set and then click Alignment > Magnification 
Alignment. 

3. Or, click either of the following buttons on the right side of the tool bar:

 Magnification Alignment

Workflow - see “Workflow” on page 196
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4. The Workflow Magnification Alignment panel appears.

5. Reposition the tile set using the directional buttons in the Workflow Magnification 
Alignment panel.

You can reposition the tile set by clicking and holding the left-mouse button while 
hovering over the tile set.

Arrow button performs 
point-to-point alignment

Check mark 
completes the 
current alignment

Slider determines 
the amount of shift 
on each button 

Directional 
buttons shift the 
selected tile sets 

X button cancels 
current alignment 
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6. Click the check mark within the alignment workflow panel to complete the current 
alignment, or click the X button to cancel it.

The results of the alignment are twofold:

 The tile set with the existing data is realigned within the Maps canvas.

 An alignment correction record is stored for the magnification associated with the tile 
set and all subsequent acquisitions will be aligned. See “Alignment Corrections 
Table” on page 153. 

Alignment Tips
 You can refine the alignment at any point in time, even when job execution is paused 

during tile set acquisition.

 A magnification alignment automatically applies to higher magnifications, so not all 
magnifications need realignment. See “Propagation of Alignment Corrections” on 
page 154.

 You can align multiple tile sets simultaneously by selecting a number of tile sets 
before starting the alignment.

 The alignment corrections are stored on disk and remain active for subsequent 
sessions. See “Alignment Corrections Table” on page 153.

 You can view which alignment corrections are present. See “Alignment Corrections 
Table” on page 153.

 If alignment corrections apply, you should see the field-of-view rectangle shift when 
changing the magnification on the system as Maps tracks the current field-of-view. 
Tracking includes the alignment corrections.
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Alignment Corrections Table
When a tile set is aligned, Maps stores a record of the magnification associated with the 
tile set. Click Options > Alignment Corrections to view the record in the Alignment 
Corrections table.
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The Alignment Corrections table is stored, so subsequent sessions also benefit from the 
alignments. Note that the corrections are not part of the project; they are part of the Maps 
global settings.

Propagation of Alignment Corrections
The magnification alignments automatically propagate to higher magnifications that do 
not have an entry in the Alignment Correction table. However, individual magnifications 
can be aligned at any time, overruling the propagated alignment. With this approach, only 
a minimum number of alignments is required and it allows for refinement when needed. 
An additional benefit of this approach is that it naturally follows the typical Maps 
workflow from low-to-high magnification, allowing you to realign during the workflow 
when needed.

Alignment corrections for the low magnification mode (LM) do not automatically 
propagate to the high magnification modes (Mi/Sa/Mh), because on TEM systems these 
modes are mostly uncorrelated. The concept of the propagation is demonstrated in the 
example described below. 

Table 8    Alignment Corrections Table Overview

Interface Item Description

Import Imports the alignment corrections.

Export Exports the alignment corrections.

Delete All Removes all alignment corrections.
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Example: Assuming you have an Alignment Corrections table as shown below and the 
system supports the magnifications as listed in Table 9, the following occurs: 

The first magnifications have no alignment correction; the LM 500x magnification has an 
alignment correction, which propagates to the next magnifications LM 1000x and LM 
1800x, but not to the high magnification modes; the first high magnifications do not have 
an entry in the alignment corrections table, hence they have no correction; the SA 5000x is 
the first high magnification with a correction, which propagates only to the next 
magnification because SA 20000x has its own entry in the alignment correction tables, 
which overrules the propagated correction of SA 5000x. The correction of SA 20000x 
propagates to all the next magnifications.

Table 9    Example of Propagation
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Working with Propagation of Alignment Corrections
 The magnification alignments are for Maps only. They determine how Maps controls 

the stage and how acquired images are positioned in the Maps canvas without 
affecting the optics of the microscope. This mechanism can safely coexist with other 
applications that use different means for realignment.

 The Magnification Alignment is related to Align Layer (see “Layer Right-Click 
Menu” on page 44) and Global Alignment functions (see “Global Alignment” on 
page 32), but serves a different purpose. The latter is intended to realign existing data 
to the coordinate system of the current system that is typically used for imported data. 
The Magnification Alignment targets alignments on the system itself.

 The magnification alignment is a mechanism to compensate for imperfections in the 
optical alignments; therefore, it is global in nature and applies to all positions. Small 
position-dependent shifts may remain due to other factors.

 If the magnification alignment for a specific magnification has changed and an 
existing tile set that was acquired before the alignment change is reacquired, the image 
shift (that is, because the alignment state changed). If this situation is detected, then 
the system displays the following warning:
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7 Sample Holders

Overview
This chapter describes the sample holders that are available for Maps.

Topics include:

 “Holder Tab” on page 157

 “Holders Supported for Automated Holder Alignment” on page 158

 “Holders Supported for Graphical Overlay” on page 161

Holder Tab
When a holder is selected and applied to the project:

 The outline displays in red on the viewer if automated holder alignment is supported. 
If automated alignment is not supported, then the outline displays in green.

 The name, drawing, version, and so on are displayed on the Holder tab.

 A new Layer is added to the Layer Control. This is where you choose to show or hide 
the Holder outline and Fiducials. The Fiducials only show after image acquisition. 
The default is to not show them. Enable the check box to view your fiducial images.

 Sample area quick access buttons appear.

- Left: Centers the view on the sample area

- Middle: Drives the stage to the center of the sample area

- Right: Creates a new tile set that covers the sample area
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Holders Supported for Automated Holder Alignment
When selected, the holder outline displays in red on the viewer, if automated holder 
alignment is supported. See “Automated Holder Alignment” on page 168.

 “3mm Grid Holder” on page 158

 “Multiwell Slide Holder” on page 164

 “Double 22 mm Coverslip Holder” on page 160

3mm Grid Holder
This is a holder for 3 mm diameter grids that can be loaded inside a transmission electron 
microscope (TEM).

Figure 1     3mm Grid Holder with Upper and Lower Fiducials Marked

Upper fiducial

Lower fiducial
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Single 22 mm Coverslip Holder
This is a single 22 mm coverslip holder. 
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Double 22 mm Coverslip Holder
This carrier holds up to two samples.
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Holders Supported for Graphical Overlay
Maps can draw a graphical overlay to assist with navigation. The graphical overlay can be 
aligned manually to other image layers, but the automated holder alignment is not 
supported on these layers,

When selected, the holder outline displays in green on the viewer, indicating that 
automated holder alignment is NOT supported.

 “Cryo Shuttle Holder” on page 162

 “Cryo SEM Shuttle Holder” on page 163

 “Multiwell Slide Holder” on page 164

 “Slide 75mm x 25mm Holder” on page 165

 “12xthin-section Quanta Mount Holder” on page 166

 “14x30mm Round Quanta Mount Holder” on page 167
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Cryo Shuttle Holder
This holder can be connected to a cooling system for imaging samples at cryogenic 
temperatures.
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Cryo SEM Shuttle Holder
This holder is used for Cryo applications. It can be connected to a cooling system for 
imaging and sample preparation at cryogenic temperatures.
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Multiwell Slide Holder
This holder is designed to handle up to six samples and may be used for live cell imaging 
applications.
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Slide 75mm x 25mm Holder
This holder represents a slide with dimensions 75 mm x 25 mm.
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12xthin-section Quanta Mount Holder
This mount holder is designed to handle up to 12 thin mineralogy samples. The mount 
holder includes a Faraday cup; meets gold, quartz, and copper standards; and has a 
magnesium calcium position.
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14x30mm Round Quanta Mount Holder
This mount holder is designed to handle up to 14 samples of 30-mm resin embedded 
mineralogy samples. The mount holder includes a Faraday cup; meets gold, quartz, and 
copper standards; and has a magnesium calcium position.
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8 Automated Holder Alignment

Overview
This chapter describes the procedure for automated holder alignment (AHA) setup, 
calibration, and operation for a particular supported holder, on both CorrSight and 
SEM/SDB systems. It is a guideline for using Maps and the automated holder alignment, 
and can also be used for CorrSight- or SEM/SDB-only as well as multi-system correlative 
Maps projects.

Topics include:

 “Holders Supported for Automated Holder Alignment” on page 168

 “Automated Holder Alignment User Interface” on page 169

 “CorrSight Holder Calibration” on page 173

 “SEM/SDB Holder Calibration” on page 180

 “Correlating Projects” on page 193

 “Troubleshooting” on page 194

Holders Supported for Automated Holder Alignment
When selected, the holder outline displays in red on the viewer. They appear in green if 
automated holder alignment is NOT supported. See “Sample Holders” on page 157.

 “3mm Grid Holder” on page 158

 “Multiwell Slide Holder” on page 164

 “Double 22 mm Coverslip Holder” on page 160

All supported holders must be manually calibrated on a given system before Automated 
Holder Alignment is possible. This is a one-time procedure. After manual calibration is 
complete, little to no manual action will be required.

N
O

T
E

Automated Holder Alignment is NOT supported for Maps on TEM systems.
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Automated Holder Alignment User Interface
Click the Align to Holder icon in the tool box and select the appropriate holder from the 
Sample Holder dropdown menu to cause the Automated Holder Alignment user interface 
to appear below the viewer.

Figure 1     Automated Holder Alignment UI

Table 1    Automated Holder Alignment UI Overview (1 of 3)

Interface Item Description

Buttons at right 
(Before Starting 
Alignment): 

Run Alignment Moves the stage to the position where it expects to find the fiducial, auto-focuses, 
and attempts to match the fiducial.

Apply Applies the alignment to the project if the alignment is not immediately applied 
when the automated procedure completes. This can be used if the automated 
alignment completes but manual adjustment is needed.

Buttons at RightFiducial Windows
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Close Closes the alignment UI and returns to the main viewer before the automated 
procedure has begun.

Buttons at Right 
(During Alignment):

Continue On SEM systems, the automated holder alignment requires manual optimization of 
the image (contrast, brightness, focus etc.). After the stage is automatically moved 
to the location of the first fiducial and the prompt for image optimization has 
appeared, use Continue to proceed with fiducial matching.

Retry Autofocuses and attempts to match the fiducial. If the match is successful, the 
automated alignment procedure will continue to the next fiducial.

Skip Skips the current fiducial matching procedure and proceeds to the next fiducial. 
This can be useful if Maps encounters difficulty matching, however, the best 
practice is to optimize the image for successful automatic matching or to manually 
select the fiducial position.

Abort Cancels the alignment procedure currently in progress and returns to the main 
viewer.

Fiducial Window

Green/Red Ball Indicates if the fiducial was found: Green = Found; Red = Not Found.

Fiducial Name Displays the name of the fiducial. In this example, Upper Left.

Reference Displays the reference image.

Table 1    Automated Holder Alignment UI Overview (2 of 3)

Interface Item Description
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Initial Displays the result of the previous alignment procedure for a project that has 
already been automatically aligned.

Current Fiducial 
Window

Displays the fiducial image acquired during the current automated holder alignment 
procedure.

Acquire Acquires an image of the specified fiducial. Maps will move to the expected 
location for the specified fiducial and attempt to match.

Fiducial Markers 
for Matching

The fiducial marker is placed on the fiducial image as a point of reference. Maps 
will align these reference points during alignment. 

• Red markers are used in the reference images to display the reference point 
that the automated procedure expects to find. 

• Blue markers are placed automatically when a match is successful. 

• Light green markers denote the reference points from the previous alignment 
procedure and appear in the Initial fiducial images.

Table 1    Automated Holder Alignment UI Overview (3 of 3)

Interface Item Description
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Executing the Holder Alignment
When using a sample holder that has already been calibrated on your microscope, the 
following procedure describes how to execute the alignment sequence.

1. Click Align to Holder.

2. Select the same holder that was just calibrated, in this case Double 22 mm coverslip 
holder, and click OK.

3. Click Run Alignment. The Alignment proceeds automatically.

 If the automated alignment is able to match all fiducials successfully, the holder 
calibration is complete.

 If the alignment failed to recognize any of the fiducials, then perform the 
appropriate calibration procedure:

— CorrSight: see “CorrSight Holder Calibration” on page 173. 

— SEM/SDB: see “SEM/SDB Holder Calibration” on page 180.
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CorrSight Holder Calibration

CorrSight Preconditions
 Tool running for at least 1 hour

 Transmitted Light channel configured in Maps

 Live imaging functional in Maps

 Camera/Image orientation:

1. Find a distinguishable feature in live imaging in Maps.

2. Click in the live imaging window to center the feature in the FOV.

3. In live imaging, click above and to the right of the feature. Verify that the feature 
moves down and left.

Performing the Calibration
1. Load the appropriate sample holder. In this example, it is Double 22 mm coverslip 

holder.

2. Create a New Project or open a project that uses the loaded holder type. Create a 
project by selecting File Menu > New Project…

3. Click the Align to Holder tool box button.

4. Select the appropriate holder from the dropdown, in this example it is Double 22 
mm coverslip holder, and click OK.

N
O

T
E This procedure is applicable to all holders on the CorrSight, only the number of fiducials 

and fiducial position is different.
N

O
T

E Refer to your application specialist for procedural information for each sample holder 
type. See “Sample Holders” on page 157 for descriptions of the other types of holders.
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5. In the fiducial alignment controls that appear, click Run Alignment. 

Maps will move the stage, autofocus, and attempt to match the fiducial. Because the 
holder has not been calibrated, the match will fail and manual adjustment will be 
required. 
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6. Click Close in the Microscope Settings dialog that appears.

7. Click the Live Imaging tool box icon to start Live Imaging in Maps.

8. Locate the correct fiducial by moving the stage. Center the fiducial in the FOV.

N
O

T
E During calibration, some matches might not select the correct fiducial hole. Retest after 
calibration and verify that the correct hole is matched automatically.
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9. Optimize the image focus in Maps Live Imaging using the mouse scroll wheel. The 
focus step size is controlled by the Step Size parameter in the Microscope controls. 
See “Step Size” on page 125.

10. Click Retry.

Maps will autofocus and attempt to match the fiducial. If the match is successful, the 
automated alignment procedure will continue to the next fiducial.

Maps will automatically attempt to match the second fiducial. If the match is not 
successful, repeat the calibration for the second fiducial (starting from Step 6). 

Once the second fiducial is recognized, Maps will automatically navigate to the final 
fiducial (for holders with more than two fiducials). If the match is not successful, repeat 
the calibration for the third fiducial (starting from Step 6).
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11. If the holder alignment succeeded and you needed to change the imaging parameters 
in the course of the alignment, then you will be prompted to save the new 
parameters. Click Yes.

12. After the alignment sequence has completed, click the Save button to commit the 
calibration to the microscope.

13. Proceed to verify the calibration.

Verifying the Calibration
1. Select none from the File > Project Properties > Sample holder dropdown.
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2. Click OK to clear the holder from the project. Click OK again at the prompt to clear.

3. Click Align to Holder.

4. Select the same holder that was just calibrated, in this case Double 22 mm coverslip 
holder, and click OK.
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5. Click Run Alignment. The Alignment proceeds automatically without manual 
adjustment. 

 If the automated alignment is able to match all fiducials successfully, the holder 
calibration is complete.

 If adjustment is still required, repeat the above procedure.
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SEM/SDB Holder Calibration

Mounting the Coverslip Holder and Adaptor to the Stage
Follow this procedure to mount the Double 22 mm coverslip holder and adaptor to the 
stage.

The holder only fits in the adaptor in one position. 

1. Withdraw the clamp and place the holder with the cut off side facing the clamp in the 
holder. The holding device (encircled in red in Figure 3) fits the hole (encircled in 
red in Figure 4) in the adaptor. 

Figure 2     Top View of the Holder 

Figure 3     Bottom View of the Holder 

Arrow indicates the 
cut off side

Arrow indicates the 
cut off side
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2. If the holder is positioned (Figure 5), release the clamp.

Figure 4     6 inch Stage Adaptor for Double 22 mm Coverslip Holder

Figure 5     Holder Positioned on Adaptor

Arrow indicates 
the clamp
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3. Place the holder and adaptor on the stage. This can only be done in one orientation. 
The adaptor has three screws (encircled in red; Figure 6) and two pins (encircled in 
green) that fit nicely into the stage (Figure 7).

4. Tighten the screws so the stage cannot move. 

5. Set the Z coordinate to 0 using the xT UI to make sure the holder will not touch the 
pole piece when inserting.

Figure 6     Adaptor Base with Screw and Pin Positions

Figure 7     Stage Screw and Pin Placement Indicators
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6. Close the chamber.

7. Press Pump.

SEM/SDB Preconditions
Before performing calibration on a Maps supported holder using an SEM/SDB system, 
verify that the following preconditions are satisfied:

 Home stage 

 SEM mode: lowest magnification

 ETD

 BSE

 10 kV

 100 pA (Use higher beam current of about 1 nA if you have difficulty matching 
automatically)

 Eucentric

 Link stage to WD

 Optimize contrast such that the fiducial holes are black and the background is white

N
O

T
E Refer to your application specialist for procedural information for each sample holder 

type. See “Sample Holders” on page 157 for descriptions of the other types of holders.
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Finding the Fiducials and Storing their Coordinates

Using the xT UI, find the upper right (UR), upper left (UL), and bottom left (BL) fiducials 
and store the coordinates on the Stage tab.

The fiducial next to the chamfer/cut off (encircled in red; Figure 8) is called upper right. 

Figure 8     Upper Right Fiducial

N
O

T
E This procedure is only necessary when starting Maps for the first time on a particular 

SEM/SDB, using a particular holder. 

N
O

T
E

The fiducial orientation must match the reference image.
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The upper right fiducial should be present at coordinates:

 X: 9.5 mm

 Y: –35.0 mm

The upper left (UL) fiducial should be present at coordinates:

 X: 9.5 mm

 Y: 35.0 mm

The bottom left (BL) fiducial should be present at coordinates:

 X: –9.5 mm

 Y: 35.0 mm

Performing the Calibration
1. Create a new project in Maps.

2. Click the Align to Holder icon in the tool box.

3. Select the appropriate holder from the Sample Holder dropdown menu, in this 
example it is Double 22 mm coverslip holder, and click OK.

N
O

T
E

Depending on the system type, X and Y coordinates might be reversed.
 If you are entirely unable to find the fiducials on the holder, perform a large overview 

tile for help in navigation. 
 If the system is equipped with a NavCam, use the NavCam navigation image to 

assist with finding the fiducials.
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4. In the fiducial alignment controls that appear, click Run Alignment. 
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5. The stage drives to the position where it expects to find the upper left fiducial. Maps 
displays a prompt to adjust microscope settings for optimal fiducial image. Click 
Close. 

6. Go to the xT UI and find the stored position for upper left fiducial. Select the upper 
left coordinates and click GoTo. The stage navigates to the stored coordinates of the 
upper left fiducial.

7. Optimize the image (set correct focus and contrast/ brightness) of the upper left 
fiducial using the xT UI. The optimal image will have completely black fiducial 
holes against a completely white background. When the image has been optimized, 
return to the Maps UI and click Continue.
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N
O

T
E

If you are having trouble matching, make sure the:
 Contrast / brightness matches reference
 Fiducial orientation matches reference
 HFW is 1.5 mm
 Sample is clean with clearly distinguishable features and no dust / contamination

N
O

T
E During calibration, Maps does not know the orientation of the holder. This can cause false 

positive matches, as shown in the diagram below. This is normal and these false positives 
will not occur after the holder has been successfully calibrated.
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8. The Microscope Settings box displays again if Maps still does not recognize the 
acquired fiducial. Click Close. 
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9. Optimize the fiducial image again to match the reference image and click Retry.

10. If Maps is not able to automatically match the fiducial, double-click to place the blue 
cross hair on the same fiducial hole that contains the red crosshair in the Reference 
image.

The red button turns green if Maps recognizes the fiducial. 

11. If Maps does not automatically navigate to the second fiducial, click Continue. 

12. Maps will automatically attempt to match the second fiducial. If the match is not 
successful, repeat the calibration for the second fiducial (starting at Step 5). Once 
the second fiducial is recognized, Maps will automatically navigate to the final 
fiducial (for holders with more than two fiducials).
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13. Since the automated alignment required manual adjustment, the Calibration prompt 
appears. Click Yes to save the holder calibration.

Verifying the Alignment
1. Select none from the File > Project Properties > Sample holder dropdown.

N
O

T
E

If the calibration prompt does not appear, Maps has low confidence in the calibrated 
fiducial positions and will not allow you to save the potentially bad calibration values. This 
can occur if there is a large unexpected rotation between fiducials. Perform the calibration 
a second time, and make sure fiducials are well centered and are oriented properly to 
match the reference.
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2. Click OK to clear the holder from the project. Click OK again at the prompt to clear.

3. Proceed to the procedure, “Executing the Holder Alignment” on page 172.
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Correlating Projects
Prerequisites for running a multi-tool correlative experiment with Maps using Automated 
Holder Alignment:

 Sample is mounted on a supported sample holder

 Holder to be used has been calibrated on all systems

To perform a correlative project:

1. Create a new project in Maps on the first system.

2. Run the AHA (automated holder alignment).

3. Acquire the desired sample data.

4. Close Maps.

5. Make a copy of the entire project directory and move it to the second system’s PC.

6. Install the supported holder into the second system.

7. Open Maps on the second system and Import the project.

8. Run the AHA.

9. Acquire the desired sample data.

10. Use alignment to adjust the position of sample data, as desired.

11. Export the results by stitching or saving images to file.

N
O

T
E Manual correlation can be performed on non-supported sample holders using the Maps 

Global Alignment procedure.
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Troubleshooting
Refer to the Maps Release Notes for any issues encountered while running Maps.

Problems with Alignment
Misalignment between data in a Maps project can be due to one or more of the following 
contributing factors:

 Stage positioning error

 Stage drift

 Modified scanning parameters

 Modified column parameters

 Microscope modality change

 Sample moved relative to holder

 Sample changed physically during sample prep

 Misalignment between imaging modes/microscope objectives

 Improper holder calibration or false positives during Automated Holder Alignment
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9 Manual Alignment

Overview
This chapter describes manual alignment workflows.

Alignment is used in Maps to adjust project data to the current stage position. For 
example, this is useful after a sample has been removed and re-installed into a system in a 
different orientation.

Alignment can be performed on imported images, tile sets, stitched tile set data, layers, 
and entire projects (Global Alignment). The procedure is identical when aligning each of 
these different objects.

It is worth noting that objects are never aligned to each other in Maps, but instead are 
aligned to the current stage position. If two objects do not match up, align the first to the 
stage, then align the second to the stage. To maintain alignment between objects, place all 
the aligned objects into a separate layer. Then, you can perform alignment on the Layer 
and all objects in the layer will be moved in unison. 

For Offline alignment where there is no stage present, simply choose one image or tile set 
as a standard and align all other data to this standard. When the project is reopened on a 
system, a single Global Alignment will correctly adjust all the project data.

There are four levels of alignment:

 Align: Aligns a single tile set or image. Selected from the “Tile Set Right-Click 
Menu” on page 46.

 Align Layer: Aligns an entire layer, including all tile sets and images at once. 
Selected from the “Layer Right-Click Menu” on page 44.

 Global Alignment: Performs an alignment to align all previously acquired data to the 
stage. Selected from the “Tool Bar” on page 30.

 Magnification Alignment: Performs an alignment to align TEM-acquired layers 
based on magnification. Selected from the “Layer Right-Click Menu” on page 44.

Topics in this chapter include:

 “1-, 2-, or 3-Point (Coarse) Alignment” on page 196

 “Fine Alignment” on page 200

 “Magnification Alignment” on page 149 (TEM systems only)
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1-, 2-, or 3-Point (Coarse) Alignment
Use 1-, 2-, or 3-point alignment to match up a previously acquired image with the current 
stage position.

 1 point: Adjusts the data using translation only. 

 2 point: Adjusts the data using translation, rotation, and scale.

 3 point: Adjusts the data using translation, rotation, scale, and orthogonality.

Workflow
The workflow described below relates to aligning a single tile set. The same procedure is 
used for all alignments in Maps.

From Tile Set:
1. Acquire a tile set.

2. Right-click on the tile set in the Layer control and select Alignment > Align. 
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From Workflow:
1. Click the workflow button and clickAlignment Wizard > Begin. The workflow 

panel opens and lists layers for alignment.

2. Select an acquired tile set to align.

3. Click the right arrow button at the bottom of the workflow panel to go to the next 
step.
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4. Follow the updated instructions in the workflow panel.

5. Follow the guided instructions in the workflow panel to find the same distinct 
feature in both windows and place Point 1, 2, or 3 in each window. You might have 
to zoom in close on a feature and grab a new preview image with more resolution to 
make the best match.
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6. Click Flip horizontal or vertical to flip the image horizontally or vertically.

7. Select 1, 2, or 3 point alignment. 

8. Click the right arrow button at the bottom of the workflow panel to enter Fine 
Alignment.
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Fine Alignment
Use Fine Alignment to fine-tune the alignment of layers and tile sets visually.

The Fine Alignment controls appear when you do the following:

 Click the right arrow button at the bottom of the workflow panel after 
a 1-, 2-, or 3-point alignment.

 Right-click the Tile Set in the Layer control and then click Alignment > Fine 
Alignment.
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Table 1    Fine Alignment Overview

Interface Item Description

Sensitivity Slider Sets the sensitivity for all of the fine alignment controls: 
Left = fine; Right = coarse.

Scale Up/Down Arrows Scales the image up or down. 

Up, Down, Left, Right, 
Up-Left, Up-Right, 
Down-Left, Down-
Right Arrows

Moves the image in the direction of the arrow.

Rotate Right, Rotate 
Left Arrows

Rotates the image in the direction of the circular arrows.

Compucentric Check 
Box

• When selected (the default), performs compucentric rotation. The image is 
pivoted around its center. 

• When not selected, the image is pivoted around the center of the stage.

Back Arrow Returns to the selection of alignment points in the coarse alignment workflow. 
From there, click Cancel if you want to undo the coarse alignment. 

Finish Check Mark Closes the Fine Alignment workflow panel.
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10 Correlation

Overview
This chapter describes the controls on the Correlation tab to apply simple coloring to the 
tile set images when they are acquired. This can be used to highlight some features for 
demonstration or evaluation purposes.

Topics include:

 “Correlation Controls” on page 202

 “Segmentation” on page 208

Correlation Controls

These controls offer post-processing capabilities for multichannel and single channel 
images.

Figure 1     Correlation Controls

See 
“Correlation 
Controls 
Overview” on 
page 204

See 
“Selected 
Channel 
Histogram 
Overview” on 
page 207
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Figure 2     Correlation Controls

See “Histogram” on 
page 206

See “Correlation 
Controls Overview” on 
page 204
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Table 1    Correlation Controls Overview (1 of 2)

Interface Item Description

Name Displays the selected layer item (a tile set or image) from the Layer control.

Opacity Sets the measure of opaqueness for the entire image. The less opaque, the more 
transparent it becomes. Transparent images are useful when overlaying on image 
over another.

Expand/Collapse 
Histogram View

Shows/hides the histogram. See “Histogram” on page 206.
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Channels with 
Opacity slider and
Gamma adjuster

1. Turns on/off display of that channel

2. Channel opacity slider (adjusts opacity for this channel only)

3. Graphical display of the gamma curve adjustment

4. Channel color selector

5. Gamma slider

Saturation Select this check box to display saturated pixels in yellow.

Fluorescence Select this check box to designate this channel as fluorescent. Fluorescent channels 
are drawn differently; black is considered transparent and colors are added with 
other channels/images behind it.

Add Color Launches Segmentation. Displays an additional histogram every time you click the 
button. See “Segmentation” on page 208.

Channel color selector Select the box to the left of Add Color to display the color picker. Choose a unique 
color for each channel to display in the histogram.

Table 1    Correlation Controls Overview (2 of 2)

Interface Item Description

1

2

3

4

5
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Histogram
Displays a histogram for the selected channel. Click a different channel name to select its 
histogram and associated color.

Figure 3     Selected Channel Histogram

Hide histogram

Inverts the 
intensity of the 
image, e.g., 
black to white

Histogram data

Current Max position

Current Min position

Max slider

Min slider
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Table 2    Selected Channel Histogram Overview

Interface Item Description

Selected channel name Displays the selected layer item (a tile set or image) from the Layer control.

Hide Hides the histogram.

Zoom Expands the histogram area of images with less than 255 colors.

Semi-log When selected, changes the histogram intensity display to logarithmic.

Invert Inverts the intensity of the image, e.g., black to white.

Auto When selected, continuously adjusts the min and max for the histogram display.

Current max position Displays the current max slider position.

Max slider Any data above the max line is white. Gray levels display between the max and min 
sliders.

Histogram data Displays the histogram data for the selected channel.

Min slider Any data below the min line is black. Gray levels display between the max and min 
sliders.

Current min position Displays the current min slider position.
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Segmentation
Topics include:

 About, below

 Add Color, below

 “Segmentation Controls Overview” on page 212

About
Image segmentation is the process of partitioning a digital image into sets of pixels, called 
segments. The goal of segmentation is to simplify and/or change the representation of an 
image into something that is more meaningful and easier to analyze.

In Maps, images and tile sets can be segmented such that each segment is assigned a color. 
Segments are defined using the image histogram and a min/max slider that determines the 
regions of the image to be included in the segment. Additionally, Maps automatically 
calculates the number of pixels within the segment as a percentage of the total number of 
pixels and displays the result.

Add Color
1. Click Add Color to add an additional image segment.

2. Choose a color from the Color Selector and select the Solid check box. When not 
selected, the color will be a gradient. See “Segmentation, One Color with Gradient” 
on page 211. 
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3. Adjust the Max and Min sliders to change the range of the histogram data to be 
assigned to the segment.

Figure 4     Segmentation, One Color
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4. Click Add Color again to add another image segment. In this example, the color 
green and the Solid check box were selected.

5. Adjust the Max and Min sliders to select a different range of the histogram data to 
be assigned to the second image segment.

Figure 5     Segmentation, Two Colors
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Segmentation, One Color with Gradient

When the Solid check box is not selected, the histogram fill color is a gradient from light 
to dark.

Figure 6     Segmentation, One Color with Gradient
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Segmentation Controls Overview

Table 3    Segmentation Controls Overview

Interface Item Description

Remove Removes the segment from the image and returns to normal display.

Color Picker Displays the color picker for selecting a color, then colors the area between the Min 
and Max sliders with the selected color.

Solid When selected, the data between min and max on the Segmentation histogram will 
be one color instead of a gradient.

% Calculates the number of pixels between min and max as a percentage of the entire 
image.
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11 Maps-Avizo/Amira Connectivity Bridge

Overview
This chapter describes how to set up and use the link between Avizo/Amira and Maps.

Topics include:

 Prerequisite, below

 “Defining Shared Folder” on page 214

 “Avizo/Amira Settings” on page 217

 “Connection Messages” on page 218

 “Sending an Image to Avizo/Amira” on page 219

 “Analyzing with Avizo/Amira” on page 220

 “Receiving AOI from Avizo/Amira” on page 221

Prerequisite
Maps 3.3 and Avizo 9.3 or Amira 6.3 are installed. They must be on the same network.
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Defining Shared Folder
A shared folder is necessary to allow data exchanges. This folder can be located in any 
place, as long as it is accessible to both software applications. It can be located on one of 
the two computers.

1. To share a folder, determine the folder you want to share.

2. Right-click on the folder and click Show Properties.

3. Click Share in the Properties dialog box.
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4. Select Everyone for Name and Read/Write for Permission Level and click Share.



Maps-Avizo/Amira Connectivity Bridge ■ Defining Shared Folder

P N  1 1 4 8 9 1 3 - A  ■ 1 1 / 0 3 / 1 7 216

Maps 3.3 User GuideFEI CONFIDENTIAL, Limited Rights Data

5. Right-click on the shared folder and select Map Network Drive to define the shared 
folder as a network drive to simplify the access to this folder.
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Avizo/Amira Settings
Select Options > Avizo/Amira Settings to display the settings window. Filling those 
settings is mandatory before using the feature.

Table 1    Avizo/Amira Settings Overview

Interface Element Description

Shared folder path from Maps 
PC

Browse to the shared folder. The selected path must be correct for 
usage on the Maps PC.

Shared folder path from 
Avizo/Amira PC

Input the access path to the shared folder. This path must be correct 
for usage on the Avizo/Amira PC.

Avizo/Amira IP Address Displays the IP address of Avizo/Amira PC. This input field must 
be filled-in.

Maps IP Address Displays the IP address of Maps PC. This input field must be filled-
in.

Test connection Checks the current connection between the Avizo/Amira 
application and Maps PC.
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Connection Messages
Connection messages indicate:

 The status of connection with Avizo/Amira

 Maps and Avizo/Amira are using the same Shared folder

 The status of Avizo/Amira pool 

If the Avizo/Amira host IP address is incorrect, or the Avizo/Amira application is not 
launched, the following message is displayed.
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Sending an Image to Avizo/Amira
1. Select an image layer and click Analyze with Avizo.

The image layer is displayed into Avizo/Amira. In the Layer control, an icon 
indicates which image layer is currently analyzed by Avizo/Amira.
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Analyzing with Avizo/Amira
From the displayed layer, you can create an analysis workflow. 
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Receiving AOI from Avizo/Amira
In Avizo/Amira, when the specific module Export Sites to Maps is executed, the regions 
found are sent to Maps.

When connected to a microscope, Maps creates tile sets covering the regions sent by 
Avizo/Amira, using the current Active template.
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In offline mode, Maps creates Areas of Interest instead of tile sets.
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12 Array Tomography

Overview
This chapter describes how to create an Array Tomography (AT) job using Maps software. 
Maps AT functionality requires an active AT license.

Topics include:

 “About Array Tomography” on page 223

 “Terminology” on page 224

 “Array Tomography Workflow” on page 225

 “Extended Controls” on page 242

About Array Tomography
AT is an imaging technique in which 3D image data is reconstructed from serial 
recordings on serial sections that are spread out on a large sample carrier. 

Samples
Samples for AT are produced by serial sectioning of a plastic-embedded sample in a 
microtome. Sections are deposited on ITO-coated glass substrates (that is, 22 x 22mm 
cover glasses) or on wafers. 

Depositing samples is done manually or by a tape collection device (that is, ATUMtome). 
The resulting AT samples differ fundamentally:

Figure 1     Classic and Tape Ribbons

Classic Ribbons: Sections 
manually deposited on cover 

Tape Ribbons: Sections collected on 
tape, mounted on wafer.
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Sample Sections and Tile Set Arrays
The main purpose of the AT feature is to easily align high-resolution imaging on areas of 
interest on all sample sections. The AT feature set consists of a new concept called a Tile 
Set Array. The Tile Set Array sets up local coordinate systems around the individual 
sample sections to create a collection of tile sets across all sample sections.

Terminology
 Classic Ribbons

Sample sections are attached to each other and the ribbon is always slightly bent. The 
angle between each section is constant, for the most part.

 Serial Section Array

The layer group that contains tile set arrays and section outlines. The purpose of the 
group is to easily contain most of the array tomography data about a sample in one 
section of the Layer tree.

 Tape Ribbons

Sample sections are regularly spaced and the angle between each slice varies slightly.

 Tile Set Array

A collection of tile sets that all share the same acquisition parameters, but can differ in 
location and rotation. 

 Workflow

A series of steps that are necessary to complete a task. 

Workflow Tool Bar

Figure 2     Workflow Tool Bar Buttons

Move View 
to Previous 
Section

Apply Changes 
to the Current 
Item

Start 
Workflow

These buttons are only available when the 
Array Tomography option is licensed.

Apply Changes 
to All of the 
Items

Apply Changes to the 
Current Item and 
Those Following

Apply Changes 
to the Current 
Item and Those 
Before It

Move View 
to Next 
Section
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T

Array Tomography Workflow
An AT job is a new workflow used within the Maps Workflow panel. The workflow panel 
is a control that contains step by step processes that help make complicated jobs easier. 
The workflows available depend on your product license. 

Click the Start Workflow button to get started.

Table 1    Workflow Tool Bar Descriptions

Tool Description

Apply Changes to the 
Current Item

Applies changes only to one (selected) tile set.

Apply Changes to All of 
the Items

Applies changes to all tile sets within the array.

Apply Changes to the 
Current Item and Those 
Following

Applies changes to the current tile set and all those following it in the array.

Apply Changes to the 
Current Item and Those 
Before It

Applies changes to the current tile set and all those before it in the array.

Move View to Previous 
Section

(Enabled when you select a tile set from an array or a section.)

Navigates to the previous section to view the newly acquired data.

Move View to Next Section (Enabled when you select a tile set from an array or a section.)

Navigates to the next section to view the newly acquired data.

Start Workflow Begins the step-by-step workflow sequence.
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In the Select Workflow window that appears, click Array Tomo and then click Begin to 
start the workflow.

When a workflow has started, a new interface panel appears on the right side of the main 
screen.

To navigate through the workflow, use the forward and back buttons located at the bottom 
of the panel. To exit the workflow, click the X button at the top right of the panel.
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Array Tomography Workflow Steps
The Array Tomography workflow contains two different branches to set up and capture 
images for an AT reconstruction: 

 A branch for mapping out all sections on your sample manually

 A branch for running an algorithm to auto detect the sections. 

The following diagram shows the steps for both branches:

 “Step 1: Overview Imaging” on page 228

 “Step 2: Section Detection Mode” on page 228

 “Step 3a(1): Automatic Section Finder” on page 230

 “Step 3a(2): Add/Remove Sections” on page 232

 “Step 3b: Assign Sections Manually” on page 233

 “Step 4: Define Section Sequence” on page 234

 “Step 5: Section Previews (optional)” on page 235

 “Step 6: Position Refinement (optional)” on page 237

 “Step 7: Create Tile Set Arrays” on page 241
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Step 1: Overview Imaging

1. Either take one or several large, low-resolution tile sets, or import images from an 
external source.

2. Place all overview images into the same layer group in the layer tree. Make sure that 
the overview images cover all sections on the sample.

3. Click the right arrow button to continue.

Step 2: Section Detection Mode

Sections are defined by a rectangular region around them. These regions serve as a local 
coordinate system for each section and are displayed in the viewer as a brown rectangle. 
This step determines the mechanism the sections are endowed with, including their 
coordinate systems. The workflow temporarily branches after this step depending on your 
selection.
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1. Select Auto Detection or Manual Creation:

 Select Auto Detection to initiate section automation. This workflow branch 
uses image recognition to search for a user-defined template image of a section 
within a collection of overview images to create sections. 

 Select Manual Creation to manually define each section. This workflow 
branch requires you to define the size and location of each section of the 
sample.

2. If you selected Auto Detection, then proceed to“Step 3a(1): Automatic Section 
Finder” on page 230. If you selected Manual Creation, then proceed to “Step 5: 
Section Previews (optional)” on page 235.
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Step 3a(1): Automatic Section Finder

This is the first step in the Auto Detection branch of the workflow. 

1. Use the mouse scroll wheel to zoom into one section. Then press Shift + left mouse 
to rotate the viewer to make the section squared up in the viewer.

2. Click Define Section Template and then draw a rectangle in the viewer that 
encompasses the section. This cuts out an image from the viewer and places it in the 
Section Template Image box. This is the image that Maps searches for in the 
overview images. The width/height/rotation of the drawn region is used to define the 
sample sections.
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3. Use the Define Pattern Image to drag a box around the sample slice in the viewer. 
This creates a cut-out image of the section that is displayed in the Pattern Image 
box in the workflow panel. This image is used as the search template in the section 
finder. 

4. Select which overview image layers to search in for the template image. 

5. Start the automated section finder by clicking Find Sections.
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6. Once the automated section finder is finished, the viewer displays the outlined 
sections.

7. Continue to the next workflow step to add/remove sections.

Step 3a(2): Add/Remove Sections

This step removes false positives found in the section finder step and to add section 
outlines for sections the auto finder may have missed. 

 To delete a false positive, select the outline in the viewer and then press Delete. 

 To add a missing section, click Add Section to generate a preview outline of the 
missing section and then mouse-click the viewer to place the outline.

T
IP Since the tool always places the section squared up, square up the section needing an 

outline in the viewer.
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8. Outline all missing sections, and then continue to the next workflow step.

Step 3b: Assign Sections Manually

Manually create a section over each of the sections. 
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1. Bring the first section into view and square it up in the viewer. 

2. Click Define Section Region to enable a section definition tool. 

3. In the viewer, drag a rectangle around the first section. This creates the first section 
and defines the section size for all following sections. 

4. To create sections for the rest of the sample, click Place Section or Add Section. 

 Place Section: This allows you to click in the viewer to place a section. There 
will be an outline of the section surrounding the mouse to help position the 
section precisely over the section. 

To adjust the rotation of the section to the sections, use the lollipop handle at the 
right side of the section. You can also rotate the image in the viewer so that the 
section borders are parallel with the monitor edges before placing the section. 
This method is recommended for Sections on Tape.

 Add Section: This places a new section down in the viewer. Its position is 
extrapolated from the positions of sections that were already added. The first two 
sections are placed near the center of the viewer. 

Adjust the position and rotation of these by clicking left-mouse + drag in the 
viewer and by using the lollipop tool for rotation. Section number three and 
subsequent sections will use the offsets of the two previous sections for placing 
them in an approximately correct position. 

— If you select the check box for Use Rotational Extrapolation, then the new 
section also takes into account the rotation offset between the previous 
sections. 

— If you select the check box for Snap View To New Section, then the viewer 
will align to the newly-created section when it is created to help verify 
placement. Use Add Section when working with a Classic Ribbon sample.

5. Fine adjust the position and rotation of all sections to save time later in the 
workflow. 

6. Repeat this sequence of creating sections until all desired sample slices have been 
covered.

Step 4: Define Section Sequence

In this step, you will set up the order of the sections. Sections that have not been ordered 
will appear in the Unordered Sections list and those ordered will show up in the Ordered 
Sections list. The ordered sections list will also display the previous index to show what is 
changing.

The ordering tool is a viewer tool that allows you to draw a line through a collection of 
sections within the viewer to determine the order. Those sections closest to the start of the 
line are first and those sections near the end of the line are at the end of the sequence. See 
images below.
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1. To use the ordering tool, click ORDER and then start drawing the sequence lines in 
the viewer. 

2. To change your current view, click VIEW to enable panning around again.

3. After you order all sections, continue to the next workflow step. 

Step 5: Section Previews (optional)

While this step is highly recommended, it is optional. If you run the “Step 6: Position 
Refinement (optional)” on page 237, this step is required.

Unordered Sections
Ordered Sections
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1. Click Go To First Section to bring the view and drive the stage to the first section.

2. Use xT to set up satisfactory imaging settings to take a higher-resolution image of 
the section compared to the overview images. 

 The imaging area for previews is always the size of the section outline +10% 
margin. It is recommended to choose the Horizontal Field Width (HFW), so that 
the preview can be recorded as a single image. However, you can select a 
smaller HFW (Maps will then use tiling to cover the area of the section). 

 The recommended imaging parameters include: 500 nm pixel size and 3µs 
dwell time. 

 Set the working distance, imaging mode, high tension, and beam current to the 
same values that will be used for high-resolution imaging. 

3. Click Acquire First Section Preview to have Maps create and acquire a tile set at 
the first section.

4. Ensure that the tile set acquires the images as desired. If everything looks good, then 
click the Acquire All Section Previews to have maps automatically create and 
acquire matching tile sets across the remaining sections.

5. You can always stop acquisition at any time and click Reset Previews to restart 
preview acquisitions from scratch. When resetting, you have the option to save the 
acquired data to a new layer group, in case you do not want to delete it.

6. Once you have acquired all section previews, continue to the next workflow step.
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Step 6: Position Refinement (optional)

If you acquired the section previews in “Step 5: Section Previews (optional)” on 
page 235, then this step is an option. This step is highly recommended to increase the 
accuracy of the placement of tile sets later.

The above schematic shows how the refinement process works. 

 Row A: This shows section outlines created on the basis of overview images, which 
do not match perfectly. 

 Row B: You select a sub-region on the first section and use it as a search template on 
the second section. The offset position of the sub-region relative to the section outline 
is stored. Template matching in the second section begins in that stored offset relative 
to the second section outline. 

If section outlines were matching perfectly, then the search template would match 
exactly at this step. If a location with a better match can be found within the search 
image, then the position of the second outline is adjusted accordingly. 

A new template is automatically cropped from the second section based on the 
matching results. This process is repeated from section-to-section until the entire set 
of sections has been refined. 

 Row C: After refinement, section outlines match much more precisely.
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1. Bring the view to the first section by clicking Bring View To First Section.

2. Click Define Refinement Region to define a refinement region in the viewer that 
will be used to begin the position refinement.

3. Drag the yellow/black border box to define the refinement region. The refinement 
region image cutout then displays in the box labeled Refinement region from 
{section}.
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4. Start the refinement process by clicking the Start Position Refinement.

While refinement is running, green rectangles are placed in the viewer where the 
refinement process found its match. The green rectangles appear from the bottom to 
the top of the screen to indicate progress.

 The refinement results (correction offset) are displayed in the Refinement 
Results box.

 To stop a refinement run, click Stop Refinement, which is highlighted in red.
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5. If the refinement fails to find a match for a given template, then the viewer will be 
brought to the section that currently failed to find a match. It will also prompt you to 
manually place the cutout. 

The goal here is to move/rotate the yellow cutout in the viewer to the correct 
location. The correct location should be in the current section and match the image 
currently shown in the Refinement region from {section} image box in the 
workflow panel. 

To help target a center spot, a green crosshair displays within the box in the viewer 
and a red crosshair displays over the image in the panel. Once the rectangle in the 
viewer is placed in the best spot, click Continue Position Refinement to continue 
the refinement run.

6. After you have refined all sections, you can easily check how well the refinement 
placed itself by using the View Controls.

 Click the two arrow buttons to view the next or previous RR (refinement 
region)/Section available. You can use this function to check the accuracy of 
the refinement region placement.

 If you find a refinement region was found in the wrong location, then click 
Change Refined Placement. This allows you to change the position/rotation of 
the refinement region in the selected section (indicated in View Controls). The 
refinement results override the selected section.

7. After you have checked the refined sections, click Apply Refinements to apply the 
refinement offsets to the section outline placement. Now, tile sets in and around the 
position refinement region will have much better section-to-section position 
stability.

8. When satisfied with the section outlines placement, continue to the next workflow 
step.

N
O

T
E Applying the refinement results is a one-time action and is not 

reversible.
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Step 7: Create Tile Set Arrays
1. Click Create tile set array to create a tile set array across all sections with a single 

click.

2. All the tile sets created within this array are linked. If the position, rotation, or 
imaging parameters of one tile set changes, then the rest of the tile sets will be 
updated. To adjust how many sections the tile set array spans, click the slider and 
drag to adjust the control bar.

3. Repeat the tile set creation until all Regions of Interest (ROI) are covered. If several 
tile set arrays are defined, each array can have different parameters.

4. Continue to the next step to begin acquisition of your newly-created tile sets.

Step 8: Array Tile Set Acquisition
1. Double check that all tile sets have been created.

2. Click ACQUIRE ALL ARRAYS to start acquisition of all the tile sets across the 
sample.

N
O

T
E

There is an exception to the tile set linking functionality in the array for one of 
the imaging parameters. The Fixed parameter in the auto-focus strategy list on 
the Auto-Functions tab is a per-tile-set setting. This allows you to manually 
focus and store the found focus position for each tile set. This allows you to 
work with samples on which auto-focus does not work.
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Extended Controls

Viewer Controls
You can create, modify, and acquire a tile set array outside of the workflow as long as 
there is a collection of mapped out sections. 

1. To do so, perform an area selection (Alt + left-click drag) within a section and 
select Create Tile Set Array Here in the menu that appears. 

This creates a new layer group for the tile set array under the Serial Section Array 
layer group and populates it with one tile set per section. 

2. To modify which sections contain a tile set from this array, select the tile set array 
Layer Group (Tile Set).
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3. Click the slider and drag to adjust the slider control bar in the Array Tomo pane to 
add or remove tile sets from sections. Alternatively, you can use the single 
incrementing buttons on either side of the slider for more precise adding and 
removing of tile sets.

When you add new tile set, it is added in the same relative location in its containing 
sections as the other tile sets in the array. This will ideally keep the tile set in the 
same location on the sample, thus making it easier for you to inspect the changes 
through the slices.

4. Click the Acquire button to start the acquisition of the whole tile set array.

Tile Set Array Layer Group Context Menu

 Copy Tile Set Array: Creates a copy of the existing tile set array group. Places it 
within the serial section array group with a name chosen by you.

 Reset Acquisitions: Resets all tile sets acquisition within the tile set array group.

Editing the Tile Set
All tile sets within one array will share acquisition parameters automatically, but location 
and rotation changes can differ between each tile set. To better handle these changes, use 
the Edit Mode buttons in the tool bar. 

Figure 3     Tile Set Edit Mode Buttons

Single: Apply 
changes only to 
one tile set.

All: Apply changes to all 
tile sets within the array.

Following: Apply changes to 
the current tile set and all those 
following it in the array.

Previous: Apply changes to 
the current tile set and all 
those before it in the array.
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Viewing the Data
Once all tile sets have been acquired, you can navigate through the sections to view the 
newly acquired data.

Select a tile set from an array or a section to enable the Toggle View buttons in the tool 
bar. 

Click the Toggle View buttons to move the view between sections. 

The viewer rotation and offset from the selected section are maintained when moved to the 
next or previous section. This allows you to quickly view a collection of tile sets or 
sections at a custom zoom and rotation.
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